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FCC Information

This is an FCC Class A product. In a domestic environment this product may 
cause radio interference in which case the user may be required to take 
adequate measures.

This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user 
will be required to correct the interference at his own expense.

RoHS

This product is RoHS compliant.

SJ/T 11364-2006

The following contains information that relates to China.
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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

International http://support.aten.com

North America http://www.aten-usa.com/product_registration

International 886-2-8692-6959

China 86-10-5160-1602

Japan 81-3-5323-7178

Korea 82-2-467-6789

North America ATEN TECH 1-888-999-ATEN

ATEN NJ 1-732-356-1703

United Kingdom 44-8-4481-58923
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Package Contents

The KN9108 / KN9116 package consists of:

1 KN9108 or KN9116 KVM Over the NET™ KVM Switch

2 Custom KVM Cable Sets

1 Power Cord

1 Rack Mount Kit

1 Foot Pad Set (4 Pads)

1 User Manual*

1 Quick Start Guide

Check to make sure that all of the components are present and in good order. 
If anything is missing, or was damaged in shipping, contact your dealer.

Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the switch or to any other 
devices on the installation.

* Features may have been added to the KN9108 / KN9116 since this manual 
was printed. Please visit our website to download the most up to date version 
of the manual.

Copyright © 2006–2009 ATEN® International Co., Ltd.
Manual Part No. PAPE-0205-4AXG

F/W Version: v1.2.111
Manual Date: 2009-12-09

Altusen and the Altusen logo are registered trademarks of ATEN International Co., Ltd. All rights reserved. All 
other brand names and trademarks are the registered property of their respective owners.
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About This Manual

This User Manual is provided to help you get the most from your KN9108 / 
KN9116. It covers all aspects of installation, configuration and operation. An 
overview of the information found in the manual is provided below.

Overview
Chapter 1, Introduction, introduces you to the KN9108 / KN9116 System. 
Its purpose, features and benefits are presented, and its front and back panel 
components are described.

Chapter 2, Hardware Setup, provides step-by-step instructions for setting 
up your installation, and explains some basic operation procedures.

Chapter 3, Logging In, describes how to log in to the KN9108 / KN9116 
with each of the available access methods: from a local console; an internet 
browser; a stand-alone Windows application (AP) program; and a stand-alone 
Java application (AP) program

Chapter 4, Administration, explains the administrative procedures that are 
employed to configure the KN9108 / KN9116’s working environment, as well 
as how to operate the KN9108 / KN9116 from the local console.

Chapter 5, Browser Operation, describes how to log into the KN9108 / 
KN9116 with your browser, and explains the functions of the icons and buttons 
on the KN9108 / KN9116 web page.

Chapter 6, The User Interface, explains how to connect to the KN9108 / 
KN9116 with the WinClient ActiveX Viewer and Java Applet Viewer 
software, and describes how to use the OSD to access and control the 
computers connected to the switch.

Chapter 7, The Log File, shows how to use the log file utility to view all the 
events that take place on the KN9108 / KN9116.

Chapter 8, The Log Server, explains how to install and configure the Log 
Server.

Chapter 9, LDAP Server Configuration, explains how to configure the 
KN9108 / KN9116 for LDAP / LDAPS authentication and authorization with 
Active Directory or OpenLDAP.

An Appendix, at the end of the manual provides technical and 
troubleshooting information.
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Conventions
This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means 
to press the Enter key. If keys need to be chorded, they 
appear together in the same bracket with a plus sign 
between them: [Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential 
steps.

→ Indicates selecting the option (on a menu or dialog box, for 
example), that comes next. For example, Start → Run 
means to open the Start menu, and then select Run.

Indicates critical information.
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Terminology
Throughout the manual we make reference to the terms Local and Remote in 
regard to the operators and equipment deployed in a KVM Over the NETTM 
switch installation. Depending on the point of view, users and servers can be 
considered Local under some circumstances, and Remote under others:

Switch’s Point of View
Remote users – We refer to a user as a Remote user when we think of 
him as someone who logs into the switch over the net from a location 
that is remote from the switch.
Local Console – The keyboard mouse and monitor connected directly 
to the switch.
Servers – The servers attached to the switch via KVM Adapter Cables.

User’s Point of View
Local client users – We refer to a user as a Local client user when we 
think of him as sitting at his computer performing operations on the 
servers connected to the switch that are remote from him.
Remote servers – We refer to the servers as Remote servers when we 
think of them from the Local Client User’s point of view – since, 
although they are locally attached to the switch, they are remote from 
him.

When we describe the overall system architecture we are usually speaking 
from the switch’s point of view – in which case the users are considered 
remote. When we speak about operations users perform via the browser, 
viewers, and AP programs over the net, we are usually speaking from the user’s 
point of view – in which case the switch and the servers connected to it are 
considered remote.

Product Information

For information about all ALTUSEN products and how they can help you 
connect without limits, visit ALTUSEN on the Web or contact an ALTUSEN 
Authorized Reseller. Visit ALTUSEN on the Web for a list of locations and 
telephone numbers:

International http://www.aten.com

North America ATEN TECH http://www.aten-usa.com

ATEN NJ http://www.aten.com
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Chapter 1
Introduction

Overview

The KN9108 / KN9116 is an IP-based KVM control unit that allows both local 
and remote operators to monitor and access multiple computers from multiple 
consoles. A single KN9108 / KN9116 can control up to 8 / 16 computers.

Since the KN9108 / KN9116 uses TCP/IP for its communications protocol, it 
can be accessed from any computer on the Net - whether that computer is 
located down the hall, down the street, or halfway around the world.

Access to any computer connected to the installation from the local console is 
easily accomplished by means of a powerful mouse driven graphical OSD (On 
Screen Display) menu system. A convenient Auto Scan feature also permits 
automatic scanning and monitoring of the activities of all computers running 
on the installation one by one.

Remote consoles connect to the KN9108 / KN9116 via its IP address. Software 
utilities are provided with the KN9108 / KN9116 that make remote access 
smooth and efficient. System administrators can handle a multitude of 
maintenance tasks with ease - from installing and running GUI applications, to 
BIOS level troubleshooting, routine monitoring, concurrent maintenance, 
system administration, rebooting and even pre-booting functions - all from the 
remote console.

KN9108 / KN9116

Local

Remote
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Remote operators can log in from anywhere on the LAN, WAN, or Internet via 
their browsers. Once they successfully log in, operators can take control using 
either the WinClient ActiveX Viewer or Java Applet Viewer utility. Inclusion of 
a Java-based client ensures that the KN9108 / KN9116 is platform 
independent, and is able to work with all operating systems.

The client software allows operators to exchange keyboard, video and mouse 
signals with the computers attached to the KN9108 / KN9116 just as if they 
were present locally and working on the equipment directly.

With the KN9108 / KN9116's Panel Array feature, the video output of up to 8 
/ 16 computers can be displayed at the same time.

The Message Board allows widely separated users to conveniently and 
instantly communicate with one other. It also includes features that allow users 
to take control of share ports.

The KN9108 / KN9116 features high density 15 pin CPU port connectors 
instead of the usual 25 pin connectors. This space-saving innovation allows a 
full 8 / 16 port switch to be conveniently installed in one unit of system rack 
space.

Setup is fast and easy - plugging cables into their appropriate ports is all that is 
entailed. Because the KN9108 / KN9116 intercepts keyboard input directly, 
there is no need to get involved in complex installation routines or to be 
concerned with incompatibility problems.

Since the KN9108 / KN9116's firmware is upgradable over the Internet, you 
can stay current with the latest functionality improvements simply by 
downloading firmware updates from our website as they become available.

With its advanced security features, the KN9108 / KN9116 is the fastest, most 
reliable, most cost effective way to remotely access and manage widely 
distributed multiple computer installations.
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Features

8 (KN9108) / 16 (KN9116) port remote access KVM switch – monitor and 
control up to 8 / 16 computers from a single console
Remotely access computers via LAN, WAN, or the Internet – control your 
installation when and where you want
Dual-bus – one local and one remote user can simultaneously control 
separate ports
Internet browser access, WinClient ActiveX Viewer and Java Applet 
Viewer provided, Java Applet Viewer works with all operating systems*
Graphical OSD and toolbars for convenient, user-friendly operation
Up to 64 user accounts – up to 32 concurrent logins
Panel Array Mode – view all 8 or 16 ports at the same time
Message board feature allows logged in users to communicate with each 
other and allows a user to take exclusive control of the KVM functions
On-screen keyboard with multilanguage support
BIOS-level access
Windows-based Log Server
Remote power control for attached Power over the Net™ devices
Three level login security: Administrator, User, and Select
End session feature – administrators can terminate running sessions
Advanced security features include password protection and advanced 
encryption technologies – 1024 bit RSA, 256 bit AES, 56 bit DES, and 
128 bit SSL
Enhanced mouse data encryption security to AES and 3DES standards
Private CA
RADIUS server support
Flash upgradable firmware over network connection
Ports can be set to Exclusive, Occupy and Share
Supports 10Base-T, 100Base-T, TCP/IP, HTTP, and HTTPS
High video resolution – up to 1280 x 1024 @ 75Hz; 1600 x 1200 @ 60Hz
Front panel can separate from main chassis for convenient front and rear 
1U rack mounting

* Browsers must support 128 bit SSL encryption.
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System Requirements

Remote User Computers
Remote user computers (also referred to as client computers) are the ones the 
users log into the switch with from remote locations over the internet (see 
Terminology, page xii). The following equipment must be installed on these 
computers:

For best results we recommend that the computers used to access the 
switch have at least a P III 1 GHz processor, with their screen resolution 
set to 1024 x 768.
Browsers must support 128 bit SSL encryption.
For best results, a network transfer speed of at least 128kbps is 
recommended.
For the WinClient AP Control Panel, DirectX 8 must be present, and at 
least 90MB of memory must be available after installation.
For the Java Client AP Control Panel, the latest version of Sun's Java 
Runtime Environment (JRE) must be installed, and at least 145MB of 
memory must be available after installation.
For the browser-based WinClient ActiveX Viewer, DirectX 8 must be 
present, and at least 150MB of memory must be available after 
installation.
For the browser-based Java Applet Viewer the latest version of Sun's Java 
Runtime Environment (JRE) must be installed, and at least 205MB of 
memory must be available after installation.
For the Log Server, you must have the Microsoft Jet OLEDB 4.0 or higher 
driver installed.

Servers
Servers are the computers connected to the KN9108 / KN9116 (see 
Terminology, page xii). The following equipment must be installed on these 
servers:

A VGA, SVGA, or multisync port.
A 6-pin mini-DIN (PS/2) keyboard port.
A 6 pin mini-DIN (PS/2) mouse port.
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Video
Only the following non-interlaced video signals are supported:

Cables
Substandard cables may damage the connected devices or degrade overall 
performance. If you need additional cables, we strongly recommend that you 
see your dealer to purchase our high quality CS Custom Cable sets.

Resolution Refresh Rates

640 x 480 60, 70, 72, 75, 85, 90, 100, 120

720 x 400 70, 75

800 x 600 56, 60, 70, 75, 85, 90, 100, 120

1024 x 768 60, 70, 75, 85, 90, 100

1152 x 864 60, 70, 75, 85

1280 x 1024 60, 70, 75, 85

1600 x 1200 60

Part Number Length (m)

2L-5201P 1.2

2L-5202P 1.8

2L-5203P 3.0

2L-5206P 6.0

2L-5702P 1.8
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Operating Systems
Supported operating systems for remote user computers that log into the 
KVM Over the NETTM switch include Windows 2000 and higher, and 
those capable of running Sun's Java Runtime Environment (JRE) 6, 
Update 3, or higher (Linux, Mac, Sun, etc.).
Supported operating systems for the servers that are connected to the 
switch’s ports are shown in the table, below:

Browsers
Supported browsers for users that log into the KVM Over the NETTM 
switch include the following:

Note: See Mac Systems, page 130, for further information.

OS Version

Windows 2000 and higher

Linux RedHat 7.1 and higher

Fedora Core 2 and higher

SuSE 9.0 and higher

Mandriva (Mandrake) 9.0 and higher

UNIX AIX 4.3 and higher

FreeBSD 4.2 and higher

Sun Solaris 8 and higher

Novell Netware 5.0 and higher

DOS 6.2 and higher

Browser Version

IE 6 and higher

Firefox 1.5 and higher

Mozilla 1.7 and higher

Opera 9.0 and higher

Netscape 8.1 and higher
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Components

Front View
KN9108:

KN9116:

2 3

1

4 5 6

2 3

1

4 5 6
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No. Component Description

1 Port LEDs The Port LEDs provide status information about their 
corresponding KVM Ports. There is one pair of LEDs for 
each Port. The one on the left is the On Line LED; the one 
on the right is the Selected Port LED:

An On Line LED lights GREEN to indicate that the 
computer attached to its corresponding port is up and 
running.

A Selected LED lights ORANGE to indicate that the 
computer attached to its corresponding port is the one 
that has the KVM focus. The LED is steady under 
normal conditions, but flashes when its port is accessed 
under Auto Scan Mode (see Auto Scanning, page 67).

When the KN9108 / KN9116 is first powered on, the On 
Line and Selected LEDs blink in sequence as the Switch 
performs a self-test.

2 Reset Switch Note: This switch is recessed and must be pushed with a 
thin object - such as the end of a paper clip, or a ballpoint 
pen.

Pressing and holding this switch in while powering on 
the KN9108 / KN9116 makes the switch use the factory 
installed firmware version rather than the firmware 
version that the switch has been upgraded to. This 
allows you to recover from a failed firmware upgrade 
and gives you the opportunity to try upgrading the 
firmware again.

Pressing and holding this switch in for more than two 
seconds performs a system reset.

3 Link LED Flashes GREEN to indicate that a Client program is 
accessing the device.

4 10/100 Mbps 
Data LED

The LED lights ORANGE to indicate 10 Mbps data 
transmission speed.

The LED lights GREEN to indicate 100 Mbps data 
transmission speed.

5 Power LED Lights when the KN9108 / KN9116 is powered up and 
ready to operate.

6 Port Switching 
Buttons

Press Port DOWN to switch from the current port to the 
previous port on the installation.

Press Port UP to switch from the current port to the next 
port on the installation.
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Rear View

KN9108:

KN9116:

41 2 3

5 6

41 2 3

5 6
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No. Component Description

1 Power Socket The power cable plugs in here.

2 Power Switch This standard rocker switch powers the unit on and off.

3 PON Port This connector is provided for a Power over the Net™ 
(PON) unit to plug into. A PON device allows computers 
attached to the KN9108 / KN9116 to be booted remotely 
over a LAN, WAN or the Internet. Contact your dealer for 
more details.

4 KVM Ports
(CPU Ports)

The cables that link the KN9108 / KN9116 to the 
computers plug in here. The shape of these connectors 
has been specifically modified so that only cables 
designed to work with this switch can plug in (see Cables, 
page 5).

5 LAN Port The cable that connects the KN9108 / KN9116 to a LAN, 
WAN or the Internet plugs in here.

6 Local Console 
Section

The KN9108 / KN9116 can be accessed via a local 
console as well as over a LAN, WAN or the Internet. The 
cables for the local console (keyboard, monitor, and 
mouse) plug in here. Each port is color coded and marked 
with an appropriate icon to indicate itself.
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Chapter 2
Hardware Setup

Before You Begin

1. Important safety information regarding the placement of this 
device is provided on page 123. Please review it before proceed-
ing.

2. Make sure that power to all the devices you will be connecting 
up have been turned off. You must unplug the power cords of 
any computers that have the Keyboard Power On function.
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Rack Mounting

The KN9108 / KN9116 can be mounted in a 1U system rack. For convenience 
and flexibility, the mounting brackets can screw into either the front or the back 
of the unit so that it can attach to the front or the back of the rack. Alternately, 
the front and rear modules can be separated so that the front module can be 
mounted at the front of the rack while the rear module is mounted at the rear. 
To rack mount the unit do the following:

1. Remove the four screws that attach the front and rear modules.

2. Using the screws provided with the rack mounting kit, screw the rack 
mounting brackets into the sides of the unit at the front and/or the rear, as 
shown in the diagrams below.

3. Slide the unit into the rack and secure it to the rack.

Phillips hex head
M3 x 8                   

Phillips hex head
M3 x 8                   
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Installation

Installing your new KN9108 / KN9116 KVM Switch involves the following 
six steps (refer to the diagram below).

1. Plug your keyboard, mouse, and monitor into the unit's Console Ports.

2. Use KVM cable sets (see Cables, page 5), to connect any available CPU 
Port to the Keyboard, Video and Mouse ports of the computer you are 
installing.

3. Plug the LAN, WAN or Internet cable into the KN9108 / KN9116's RJ-45 
socket.

4. Plug the female end of the power cord into the KN9108 / KN9116's Power 
Socket; plug the male end into an AC power source.

5. Turn on the power to the KN9108 / KN9116.

6. After the KN9108 / KN9116 is powered up, turn on the computers.

Note: Although the KN9116 is pictured in the diagram, the installation 
process is the same for the KN9108.

4

3

1

2
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Hot Plugging

The KN9108 / KN9116 supports hot plugging - components can be removed 
and added back into the installation by unplugging and replugging their cables 
from the ports without the need to shut the unit down.

If you change computer positions, however, in order for the OSD menus to 
correspond to the CPU port changes, you must manually edit the Port Names 
for the OSD to reflect the new Port information. See Port Names, page 30, for 
details.

Note: If the computer's operating system does not support hot plugging, this 
function may not work properly.

Port ID Numbering

Each CPU port on the installation is assigned a unique Port ID. The Port ID is 
a two digit number which reflects the CPU Port on the KN9108 / KN9116 that 
the computer is connected to. Port numbers from 1 - 9 are padded with a 
preceding zero, so they become 01 - 09.

For example, a computer attached to Port 6 would have a Port ID of: 06.

Powering Off and Restarting

If it becomes necessary to power off the KN9108 / KN9116, or if the switch 
loses power and needs to be restarted, wait 10 seconds before powering it back 
on. The computers should not be affected by this, but if any of them should fail, 
simply restart the affected computers.

Port Selection

Port Selection is accomplished either by entering Hotkey combinations from 
the keyboard, or by means of the OSD (On Screen Display). Hotkey Port 
Selection is discussed in the next chapter; OSD Operation is discussed in detail 
in Chapter 6, and Chapter 6.
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Chapter 3
Logging In

Overview

KN9108 / KN9116 switches can be accessed from a local console; an internet 
browser; a Windows application (AP) program; and a Java application (AP) 
program.

No matter which access method you choose, the switch’s authentication 
procedure requires you to submit a valid username and password. If you supply 
an invalid login, the authentication routine will return an Invalid Username or 
Password, or Login Failed message. If you see this type of message, log in 
again with a correct username and password.

Local Console Login

After the local console has been connected and the KN9108 / KN9116 turned 
on, a login prompt appears on the console monitor:

If this is the first time you are logging in, use the default Username: 
administrator; and the default Password: password. For security purposes, we 
strongly recommend that you use the User Management function (see page 36) 
to remove these and give yourself a unique Username and Password with the 
appropriate permissions.

Otherwise, simply key in your Username and Password, then click Login to 
bring up the Local Console OSD. The Local Console OSD is similar to the 
WinClient and Java Applet Viewer Main Pages. See The User Interface, 
page 63.
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Browser Login

To log into the KN9108 / KN9116 from an Internet browser:

1. Open the browser and specify the IP address in the URL bar.

Note: For security purposes, a login string may have been set by the 
Administrator (See Security, page 47, for details). If so, you must 
include a forward slash and the login string along with the IP address 
when you log in. For example:

192.168.0.60/kn9116

Ask your Administrator for the IP address and login string.

2. When the Security Alert dialog box appears, accept the certificate – it can 
be trusted. (See Trusted Certificates, page 137, for details.)

3. A login page appears:

4. Provide a valid Username and Password (set up by the KN9108 / KN9116 
administrator), then Click Login to continue.

Note: 1. If you supply an invalid login, the authentication routine will 
return a message stating, Invalid Username or Password. Please 
try again. If you exceed the number of login failures set by the 
Administrator, a timeout period is invoked. You must wait until 
the timeout period expires before you can attempt to log in again 
(See Login Failures, page 49, for details).

2. If you are the Administrator and are logging in for the first time, 
use the default Username: administrator; and the default 
Password: password. For security purposes, we strongly 
recommend you remove these and give yourself a unique 
Username and Password (see User Management, page 36).

After you have successfully logged in, the KN9108 / KN9116 Main Web page 
appears with the General dialog box displayed. See Chapter 5, Browser 
Operation for full details.
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WinClient AP Login

In some cases, the Administrator may not want the KN9108 / KN9116 to be 
available via browser access. AP versions of the WinClient and the Java Client 
are provided to enable direct access of the KN9108 / KN9116 without having 
to go through a browser.

The programs are initially downloaded from the browser page. After they have 
been downloaded by the Users, the Administrator can disable browser access 
(see Working Mode, page 49).

Installation
To install the WinClient AP on your computer, do the following:

1. Log into the KN9108 / KN9116 with your browser, and click the second 
Windows Client button (the one with the arrow). A screen similar to the 
one below appears:

2. Click Save. In the dialog box that comes up specify a location on your 
hard disk to save it to.
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Starting Up
To connect to the KN9108 / KN9116, go to the location on your hard disk that 
you saved the WinClient AP program to, and double-click its icon 
(WinClient.exe) to bring up the WinClient AP Screen:

Note: You must have DirectX 8.0 or higher installed on your computer. If not, 
the Client program will not load.
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The Connection Screen
A description of the Connection Screen is given in the following table

Item Description

Menu Bar The Menu Bar contains two items: File and Help. 

The File Menu allows the operator to Create, Save, and Open user 
created Work files (see page 20 for details).

The Help Menu displays the WinClient AP version.

Server List Each time the WinClient.exe file is run, it searches the User's local LAN 
segment for KN9108 / KN9116 units, and lists whichever ones it finds in 
this box. If you want to connect to one of these units, double-click it.

Server This area is used when you want to connect to a KN9108 / KN9116 at a 
remote location. You can drop down the IP list box and select an 
address from the list. If the address you want isn't listed, you can key in 
the IP address you want. Then, key in the Port number in the Port field. 
If you don't know the Port number, then contact the Administrator.
When the IP address and Port number for the unit you wish to connect 
to have been specified, Click Connect to start the connection. When 
you have finished with your session, Click Disconnect to end the 
connection.

Message 
List

 Lists status messages regarding the connection to the KN9108 / 
KN9116.

Switch to 
Remote 
View

Once contact with a KN9108 / KN9116 has been established, this button 
becomes active. Click it to switch to the main page (see The User 
Interface, page 63, for full details) and take over console control of the 
unit that is attached to the KN9108 / KN9116.
The screen output of the unit appears on your monitor. Your keystrokes 
and mouse movements are captured and sent to the KN9108 / KN9116 
to be executed on the attached unit.
If the KN9108 / KN9116 is connected to a KVM switch, you can control 
the switch and the computers connected to it just as if you were 
connected locally.
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The File Menu
The File Menu allows the operator to Create, Save, and Open user created 
Work files. A Work File consists of all the information specified in a Client 
session. This includes the Server List and Server IP list items, as well as the 
Hotkey settings.

Whenever a user runs the Client program, it opens with the values contained in 
the current work file. The current work file consists of the values that were in 
effect the last time the program was closed.

The File menu consists of three items, as follows:

New Allows the user to create a named work file so its values will not 
be lost, and it will be available for future recall.

Open Allows the user to open a previously saved work file and use the 
values contained in it.

Save Allows the user to save the values presently in effect as the 
current work file.

Exit Exits the WinClient AP.
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Connecting
To connect to a KN9108 / KN9116 unit:

1. From the Server List box, double-click the device that you wish to 
connect to. Or, specify the IP address and port number in the Server IP and 
Port input boxes, and then Click Connect. The Login dialog box appears:

2. Key in a valid Username and Password, and then click OK.
The program attempts to connect to the selected KN9108 / KN9116 unit. 
While it does so, you can check the Message List window for status 
messages regarding the operation's progress.

3. Once contact with the KN9108 / KN9116 has been established, the Switch 
to Remote View button becomes active. Click it to connect to the 
KN9108 / KN9116 and take over console control of the unit that is 
connected to it.



KN9108 / KN9116 User Manual

22

Operation
Once a connection to the KN9108 / KN9116 has been established, the remote 
system's video output is captured and displayed on your monitor. At the same 
time, your local keystroke and mouse input is captured and sent to the remote 
system.

The look and feel of the WinClient AP Control Panel operation is the same as 
for the browser version of the WinClient ActiveX Viewer. Refer to The User 
Interface, page 63, for details.
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Java Client AP Login

Installation
To install the Java Client on your computer, do the following:

1. Log into the KN9108 / KN9116 with your browser, and click the second 
Java Client button (the one with the arrow). A screen similar to the one 
below appears:

2. Click Save. In the dialog box that comes up specify a location on your 
hard disk to save it to.

Starting Up
To connect to the KN9108 / KN9116 do the following:

1. Go to the location on your hard disk that you downloaded the Java Client 
AP program to, and double-click its icon (JavaClient.jar) to bring up the 
Address Input dialog box:

(Continues on next page.)
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2. Key in the IP address for the unit you want to connect to – including a 
forward slash followed by the login string (set by the administrator).

Note: 1. If the system administrator set the switch’s Program port to 
something other than the default you must specify the port 
number along with the IP address. For example: 
192.168.0.132:9111

2. For security purposes, a login string may have been set by the 
Administrator (See Security, page 47, for details). If so, you must 
include a forward slash and the login string along with the IP 
address when you log in. For example:

192.168.0.132:9111/kn9116

Ask your Administrator for the IP address and login string.

After you establish a connection, a Login dialog box appears:

3. Provide a valid Username and Password, and then click OK.
Once the authentication procedure completes successfully, the KN9108 / 
KN9116 main page displays on your monitor.

Operation
The look and feel of the AP Java client operation is the same as for the browser 
version of the Java Applet Viewer. Refer to The User Interface, page 63 for 
details.
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Chapter 4
Administration

Overview

This chapter explains the administrative procedures that let the Administrator 
(and users with administration permission - see User Management, page 36) 
configure and control the overall operations of the KN9108 / KN9116, as well 
as how to operate the KN9108 / KN9116 from the local console. The 
Administration tab is disabled (grayed out) for users who do not have 
administration permission.

The Local Console

Once the KN9108 / KN9116 has been installed, the next step that the 
Administrator needs to perform is to set up the unit for user operation. The 
most convenient way to do this for the first time is from the local console. See 
Local Console Login, page 15.

After you successfully log in, the Local Console OSD appears:

There are four buttons on the title bar at the top right. They are described below 
starting from the left and moving to the right:

Screen View: clicking this button (or pressing F6) toggles the display 
between full screen and window view.



KN9108 / KN9116 User Manual

26

Transparent: clicking this button (or pressing F7) causes the OSD display 
to become semi-transparent, allowing whatever the OSD screen is 
covering to show through. Clicking the button again causes the OSD 
display to revert back to normal opacity.

Note: 1. The Screen View and Transparent buttons are on the Local 
Console OSD only. The Web browser OSD and AP versions do 
not have these functions.

2. It is recommend that you set the refresh rate of the monitor higher 
than 75Hz before using this feature.

3. When the transparent feature is enabled, if you switch to a null 
port the feature will be disabled.

Log out: clicking this button (or pressing F8) closes the OSD display and 
logs you out of the session.
Close: clicking this button (or pressing Esc) closes the OSD display but 
does not log you out of the session. You can bring the display back with 
the OSD hotkeys (see OSD Hotkey, page 95).

The OSD consists of four pages, each with a specific set of functions: Main, 
Configuration, Administration, and Log.
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The Main Page

The Main page governs port access. Selecting a port and double-clicking it 
switches you to the device on that port.

A monitor icon is in front of the port number. The monitor icon is green 
for ports that have devices connected to them that are powered on; 
otherwise, it is gray.
 If a port has been specified as a Quick View port (see below), an eye icon 
is displayed along with the monitor icon to indicate so.

In addition to using this page to select ports to switch to, the administrator can 
also use this page to enable/disable Quick View status for selected ports, and 
to create, modify, or delete names for each of the ports. The following sections 
describe how to enable Quick View and how to assign names to ports.

Quick View Ports
Selecting certain ports as Quick View ports is a way of limiting which ports are 
included when the KN9108 / KN9116 is in Auto Scan mode. If the KN9108 / 
KN9116 is configured to only auto scan ports that have Quick View status (see 
Scan Select, page 95), designating a port as a Quick View port in this dialog 
box means that it will be included when auto scanning is in effect.

The spacebar toggles a port's Quick View status. To select/deselect a port, 
highlight it and press the spacebar. When a port has been selected as a Quick 
View port, an eye icon displays in the port icon column to indicate so. When a 
port isn't selected, there are no eye icons in the column.
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The List Function
The List Function lets you broaden or narrow the scope of which ports the OSD 
displays (lists) in the Main Screen. To invoke the List Function, click the arrow 
at the upper right corner of the screen, or press [F3]:

The screen changes to allow you to choose the ports that will be listed:
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The drop down list on the left offers four fixed choices as shown in the 
table below:

The text input box on the right allows you to key in a port name so that 
only port names that match what you key in show up in the List. Wildcards 
(? and *) are acceptable, so that more than one port can show up in the list. 
For example, if you key in Web*, both Web Server 1 and Web Server 2 
would show up in the list, as shown in the screen shot below:

After you key in your string, either click the binoculars icons to the 
right of the box, or press [Enter].
To go back to the default view, erase the string and either click the 
binoculars to the right of the box, or press [Enter].
To dismiss the List function, click the arrow or press [F3].

Choice Meaning

All Lists all of the ports on the installation.

Powered On Lists only the ports that have their attached devices powered on.

Quick View Lists only the ports that have been selected as Quick View ports 
(see Quick View Ports, page 27)

Quick View + 
Powered On

Lists only the ports that have been selected as Quick View Ports 
(see Quick View Ports, page 27), and that have their attached 
computers Powered On.
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Port Names
To help remember which computer is attached to a particular port, every port 
can be given a name. This field allows the Administrator to create, modify, or 
delete port names. To configure a port name:

1. Click once on the port you want to edit, wait one second and then click 
again. (Alternately, use the up and down arrow keys to move the highlight 
bar to the port, and then press the F2 function key.)

Note: This is not a double-click. It involves two separate clicks. A double-
click will switch you to the device attached to the port.

After a second or two, the bar changes to provide you with a text input 
box:
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2. Key in the new Port Name, or modify/delete the old one.
The maximum number of characters allowed for a Port Name is 19. You 
can use all letters, numbers, and symbols on the typewriter keys of 
keyboards with PC US English layout.

3. When you have finished editing the port name, click anywhere outside of 
the input box to complete the operation.

Port Operation

Since port operation is the same as for the Windows and Java Client OSDs, the 
procedures are discussed in Chapter 6 and Chapter 6.

When accessing servers in the switch from the local console, if you invoke the 
OSD while in the port you can press the F6 function key to hide the background 
and enlarge the OSD box. Press [F6] again to show the background.
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The Configuration Page

The OSD Configuration page allows users to set up their own, individual, 
working environments. The KN9108 / KN9116 stores a separate configuration 
record for each user profile, and sets up the working configuration according 
to the Username that is used to log in.

(Continues on next page.)
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(Continued from previous page.)

The Configuration page settings are explained in the following table:

Setting Function

OSD Hotkey Selects which Hotkey controls the OSD function: [Scroll Lock] 
[Scroll Lock] or [Ctrl] [Ctrl]. Since the Ctrl key combination may 
conflict with programs running on the computers, the default is the 
Scroll Lock combination (see Hotkey Operation, page 67).

ID Display Selects how the Port ID is displayed: the Port Number alone 
(PORT NUMBER); the Port Name alone (PORT NAME); or the 
Port Number plus the Port Name (PORT NUMBER + PORT 
NAME). The default is PORT NUMBER + PORT NAME.

ID Duration Determines how long a Port ID displays on the monitor after a port 
change has taken place. You can choose an amount from 0–255 
seconds, or enable Always On for the Port ID to be always 
displayed. The default is 5 Seconds. 0 is Always Off.

Scan Select Selects which computers will be accessed under Auto Scan Mode 
(see Auto Scanning, page 67). Choices are: ALL – All the Ports 
which have been set Accessible (see Port Access, page 38); 
POWERED ON – Only those Ports which have been set 
Accessible and are Powered On; QUICK VIEW – Only those Ports 
which have been set Accessible and have been selected as Quick 
View Ports (see Quick View Ports, page 27); QUICK VIEW + 
POWERED ON – Only those Ports which have been set 
Accessible and have been selected as Quick View Ports and are 
Powered On. The default is ALL.

Scan Duration Determines how long the focus dwells on each port as it cycles 
through the selected ports in Auto Scan Mode (see Auto Scanning, 
page 67). Key in a value from 0–255 seconds. The default is 10 
seconds; a setting of 0 disables the Scan function.

Screen Blanker If there is no input from the console for the amount of time set with 
this function, the screen is blanked. Key in a value from 1–30 
minutes. A setting of 0 disables this function. The default is 0 
(disabled).

Logout Timeout If there is no Operator input for the amount of time set with this 
function, the Operator is automatically logged out. A login is 
necessary before the KN9108 / KN9116 can be accessed again. 
Enter a value from 0–180 minutes. The default is 30 minutes. 0 
disables the function.

Beeper When set to ON, the beeper sounds whenever the port is switched, 
when activating the Auto Scan function (see Auto Scanning, 
page 67), or when an invalid entry is made on an OSD menu. The 
default is ON.

Change 
Password

Allows a user to change the account password. After clicking the 
Change Password button, a dialog box appears. Enter the old 
password. Then, enter a new password and confirm it by entering it 
again. Press OK to save changes, or press Cancel to discard 
changes.
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The Session Page

The Session page lets the administrator see at a glance all the users currently 
logged into the KN9108 / KN9116, and provides their IP address.

This page gives the administrator the option of forcing a user logout by 
selecting the user and clicking Kill Session.

The arrow at the left of the Username indicates the currently active 
administrator (i.e. you). Select another user by clicking on the Username to 
move the highlight bar (the arrow does not move) before clicking Kill Session.

Note: The Session page only appears in Administrator sessions. It is not 
available for ordinary users.
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The Administration Page

When you click the Administration tab, the Administration page comes up. 
Each of the administrative functions is represented by an icon at the left of the 
page. Clicking the icon brings up its associated dialog box. When the 
Administration page first comes up the General dialog box appears:

. 

General
The General Page presents four items of information. This is the same 
information that displays after you log in from a browser, or when you click the 
General icon at the top left of the browser main page The meaning of these 
items is described in the table below.

Item Description

Device Name This field lets you give the switch a unique name. This can be 
convenient when you need to differentiate among several 
devices in multi-station installations.

MAC Address This item displays the KN9108 / KN9116's MAC address.

Firmware Ver This item displays the current firmware version number. You can 
reference it to see if there are newer versions available on the 
Altusen website.

Last IP from DHCP 
Server

If the switch is on a network that uses DHCP assigned IP 
addresses, this item is a convenient way of ascertaining what its 
IP address is, to inform the Users which IP to use when logging 
in.
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User Management
The User Management dialog box is used to create, delete and manage user 
profiles. Up to 64 user profiles can be established.

To delete a user profile, select it in the list box, and Click Remove.
To modify a user profile, select it and Click Edit.
To add a user, Click New.

If you choose Edit or New, a dialog box similar to the one below appears:
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Fill in the required information for a new User profile, or modify the existing 
information to edit a previous profile. A description of the field headings is 
given in the table below:

Heading Description

Username A minimum of 6 and a maximum of 15 characters is allowed.

Password A minimum of 8 and a maximum of 15 characters is allowed.

Confirm Password To be sure there is no mistake in the password you are 
asked to enter it again. The two entries must match.

Description Additional information about the user that you may wish to 
include. (optional)

Admin Gives the user Administrator level access to the KN9108 / 
KN9116. All permissions are granted (see below).

User Gives the user User level access to the KN9108 / KN9116. 
WinClient ActiveX Viewer, Power Manager, and Java Client 
permissions are granted (see below).

Select If the permissions selected for the account do not match 
those specified for Administrators or Users, Select is 
automatically chosen as the account type.

Permissions 1. Checking Administration assigns administrative privi-
leges to the account, which allows the user to modify the 
KN9108 / KN9116's Administration page settings.

2. Checking Windows Client allows the user to access the 
KN9108 / KN9116 via the WinClient ActiveX Viewer soft-
ware.

3. Checking Log causes the Log Server and Log buttons to 
appear on the Main web page when the user logs in and 
allows the user to access these features.

4. Checking Power Manager causes the PON button to 
appear on the Main web page when the user logs in and 
allows the user to access attached Power over the Net™ 
devices.

5. Checking Java Client allows the user to access the 
KN9108 / KN9116 via the Java Client software.

6. Checking Force to Grayscale changes the remote display 
for all users to grayscale. This can speed up I/O transfer 
in low bandwidth situations. The default setting is disabled 
(unchecked).
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Heading Description

Port Access This function allows the Administrator or a User with 
Administration permission to define the selected User's 
access to the computers on a Port-by-Port basis.
For each User profile, select a port and click it to cycle 
through the choices:
Full - The user can view the screen and can perform 
operations on the system from the keyboard and mouse.
View - A diagonal line through the port icon indicates the 
port access is View. The user can view the screen, but 
cannot perform operations on the system.
Null (no access rights) - An X through the port icon indicates 
no port access. The Port will not show up on the User's list 
on the Main Screen.
Repeat until access rights have been set for all ports.
The default is Full for all users on all Ports.
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Service Configuration
The Service Configuration dialog is composed of two main panels: Access Port 
and Log Server:

Access Port
As a security measure, if a firewall is being used, the Administrator can specify 
the port numbers that the firewall will allow, and set the firewall accordingly. 
Users must specify the port number when they log in to the KN9108 / KN9116. 
If an invalid port number (or no port number) is specified, the KN9108 / 
KN9116 will not be found.

Note: 1. If there is no firewall (on an Intranet, for example), it doesn't matter 
what these numbers are set to, since they have no effect.

2. You must set different values for each of the service ports.

An explanation of the fields is given in the table below:

Field Explanation

Program This is the port number that must be specified when connecting 
from the WinClient ActiveX Viewer and Java Client software 
program. Valid entries are from 1024 - 60,000. The default is 9000.

HTTP The port number for a browser login. The default is 80.

HTTPS The port number for a secure browser login. The default is 443.
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Log Server
Important transactions that occur on the KN9108 / KN9116, such as logins and 
internal status messages, are kept in an automatically generated log file. In this 
panel, you specify the MAC address and a port number for the computer that 
the Log Server resides on.

Installation and operation of the Log Server is discussed in Chapter 8. The Log 
File is discussed on page 97.
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Network
The Network dialog is used to specify the KN9108 / KN9116's network 
environment. The box is divided into two panels: IP Address and DNS Server.

Network Transfer Rate
This setting allows you to tailor the size of the data transfer stream to match 
network traffic conditions by setting the rate at which the KN9108 / KN9116 
transfers data between the switch and the client computers. The range is from 
4–99999 Kilobytes per second (KBps).

IP Address
The KN9108 / KN9116 can either have its IP address assigned dynamically 
(DHCP), or it can be given a fixed IP address.

For dynamic IP address assignment, select the Obtain IP address 
automatically radio button.
To specify a fixed IP address, select the Set IP address manually radio 
button and fill in the IP address, subnet mask and default gateway.

DNS Server
You can set the KN9108 / KN9116 to automatically obtain the DNS server 
address, or you can specify the primary and alternate DNS servers' addresses.

To automatically obtain the DNS server address, select the Obtain DNS 
Server address automatically radio button.
To specify the address of the DNS server, select the Use the following DNS 
Server address radio button and fill in the addresses for the primary DNS 
server (mandatory) and alternate DNS server (optional).
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ANMS
The Advanced Network Management Settings page is used to set up login 
authentication and authorization management from external sources. Click on 
the ANMS icon to select RADIUS, LDAP, or CC Management. 

RADIUS
If you are using a RADIUS server, set up its parameters as follows:

1. Check Enable.

2. Fill in the IP addresses and Service Ports for the Primary and Alternate 
RADIUS servers.

(Continues on next page.)
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(Continued from previous page.)

3. Set the time in seconds that the KN9108 / KN9116 waits for a RADIUS 
server reply before it times out in the Timeout field.

4. Set the number of RADIUS retries allowed in the Retries field.

5. Key the Shared Security character string for authentication between the 
KN9108 / KN9116 and the RADIUS Server in this field.

6. On the RADIUS server, set the access rights for each user according to the 
information in the table on page 44.

Note: 1. The characters are not case sensitive. Capitals or lower case work 
equally well. 

2. Characters are comma delimited.

3. An invalid character in the configuration string will prohibit access to 
the KN9108 / KN9116 for the user.

Examples:

String Meaning

c,w,p User has administrator privileges; user can access the system via the 
WinClient ActiveX Viewer; user can access the attached PN0108.

w,j,l User can access the system via the WinClient ActiveX Viewer; user can 
access the system via the Java Client; user can access log information 
via the user's browser.
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Character Meaning

C Grants the user administrator privileges, allowing the user to 
configure the system.

W Allows the user to access the system via the WinClient ActiveX 
Viewer program.

J Allows the user to access the system via the Java Client program.

P Allows the user to access an attached Power Over the Net™ device.

L Allows the user to access log information via the user's browser.

PN Restricts the user from accessing the OSD port list.
Syntax: pn/1/2/3/4

PV Limits the user's access to viewing of the OSD port list only.
Syntax: pv/1/2/3/4

UHK Defines the OSD Hotkey (see OSD Hotkey, page 95)..
(uhk0: Scroll Lock + Scroll Lock; uhk1: Ctrl + Ctrl)
Syntax: uhk0

UOL Defines the OSD List Function (see page 28).
(uol0: All; uol1: Powered On; uol2: Quick View; uol3: Quick View + 
Powered On)
Syntax: uol0

UODM Selects how the Port ID displays (see ID Display, page 95).
(uodm0: Port Number + Port Name; uodm1: Port Number; uodm2: 
Port Name)
Syntax: uodm0

UODT Determines the length of time in seconds that the Port ID displays on 
the monitor after a port change (see ID Duration, page 95).
Syntax: uodtn (where n represents a number from 0-255)

UBUZ Turns the beeper on or off (see Beeper, page 95).
(ubuz0: Beeper Off; ubuz1: Beeper On)
Syntax: ubuz0

ULT When there is no input from the user for the amount of time set with 
this function, the user is automatically logged out. The user will need 
to log in again. Set the Logout Timeout from 0-180 minutes.
Syntax: ultn (where n represents a number from 0-180)

USM Selects which computers are accessed under Auto Scan Mode (see 
Scan Select, page 95).
(usm0: All; usm1: Powered On; usm2: Quick View; usm3: Quick View 
+ Powered On)
Syntax: usm0

UST Determines the length of time in seconds the KVM focus dwells on 
each port in Auto Scan Mode (see Scan Duration, page 95).
Syntax: ustn (where n represents a number from 0-255)
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LDAP / LDAPS
To allow authentication and authorization for the KN9108 / KN9116 via LDAP 
/ LDAPS, set the parameters as follows:

1. Check the box to enable LDAP / LDAPS authentication and authorization.

2. Click a radio button to specify whether to use LDAP or LDAPS

3. Fill in the IP address and port number for the LDAP or LDAPS server. For 
LDAP, the default port number is 389; for LDAPS, the default port 
number is 636.

4. Set the time in seconds that the KN9108 / KN9116 waits for an LDAP or 
LDAPS server reply before it times out.

5. Consult the LDAP / LDAPS administrator to ascertain the appropriate 
entry for this field. For example, the entry might look like this:
ou=kn4132,dc=aten,dc=com

6. Key in the LDAP administrator’s username.

7. Key in the LDAP administrator’s password.

8. Set the distinguished name of the search base. This is the domain name 
where the search starts for user names.

Note: If LDAP Settings is enabled, the LDAP schema for MS Active 
Directory must be extended. See LDAP Server Configuration, 
page 107, for details.
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CC Management Settings
To allow authorization for the KN9108 / KN9116 through a CC (Control 
Center) server, check Enable and fill in the CC Server’s IP address and the port 
that it listens on in the appropriate fields.

Note: The current firmware (insert firmware version) supports CC1000 only. 
Future firmware upgrades will provide support for CC2000. Please visit 
our website to download the most up-to-date version of the firmware.
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Security
The Security page controls access to the KN9108 / KN9116.

The Default web page name lets the Administrator specify a login string 
(in addition to the IP address) that the user must include when accessing 
the KN9108 / KN9116 with a browser or the Java Client AP. For example:

192.168.0.126/abcdefg

The user must include the forward slash and the string along with the IP 
address. For security purposes, we recommend that you change this string 
from time to time.

(Continues on next page.)
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(Continued from previous page.)
IP and MAC Filters control access to the KN9108 / KN9116 based on the 
IP and/or MAC addresses of the computers attempting to connect. A 
maximum of 100 IP filters and 100 MAC filters are allowed. To enable IP 
and/or MAC filtering, Click to put a check mark in the IP Filter Enable 
and/or MAC Filter Enable checkbox.

If the include button is checked, all the addresses within the filter range 
are allowed access to the KN9108 / KN9116; all other addresses are 
denied access.
If the exclude button is checked, all the addresses within the filter 
range are denied access to the KN9108 / KN9116; all other addresses 
are allowed access.

To add a filter, Click New. A dialog box similar to one of the ones below 
appears:

Note: Each IP filter can consist of a single address, or a range of addresses. 
To filter a single IP address, key in the same address in both the 
From and To fields. To filter a continuous range of IP addresses, key 
in the start of the range in the From field; key in the end of the range 
in the To field.

After you specify the filter addresses, Click OK.

To delete a filter, select it and Click Remove.
To modify a filter, select it and Click Edit. The Edit dialog box is similar 
to the New dialog box. When it comes up, simply delete the old address 
and replace it with the new one.
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Customization 
The Customization dialog box is arranged in four major sections:

Login Failures
Allowed: sets the number of consecutive failed login attempts that are 
permitted from a remote computer.
Timeout: sets the amount of time a remote computer must wait before 
attempting to login again after it has exceeded the number of allowed 
failures.

Working Mode
If Stealth Mode is enabled, the KN9108 / KN9116 refuses ICMP "echo 
request" packets.
To permit browser access to the KN9108 / KN9116, click to put a check 
mark in the Enable Browser checkbox. If browser access is not enabled, 
users will not be able to log into the unit via their browsers.
To permit multiple users to simultaneously access the KN9108 / KN9116, 
check Enable multiuser operation.
If Force all the grayscale is enabled, the remote displays of all devices 
connected to the KN9108 / KN9116 are changed to grayscale. This can 
speed up I/O transfer in low bandwidth situations.
If Enable black background is checked, the remote OSD displays on a 
black background.
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I/O

Attributes
Attributes allows you to set attribute parameters for each of the ports.

To change the port attribute:

1. Click Attributes... on the Customization dialog box. The Setting I/O 
Attributes dialog box appears. The port numbers are listed in the column 
on the left. The port's attributes are shown to its right.

2. Double-click on a port entry. The I/O attributes dialog box appears:

3. Select a Share Mode attribute for the port (see the table below)

4. Click OK. (To exit without saving your changes, click Cancel.) The 
dialog box closes.

5. On the Setting I/O Attributes dialog box click Apply to keep your changes. 
(To exit without saving your changes, click Cancel.)

Attribute Definition

Exclusive The first user to switch to the port has exclusive control over 
the port. No other users can view the port. The Timeout 
function does not apply to ports which have this setting.

Occupy The first user to switch to the port has control over the port. 
However, up to 32 users may view the video from the port. If 
the user who controls the port is inactive for longer than the 
time set in the Timeout box, port control is transferred to the 
next user to move the mouse or strike the keyboard.

Share Up to 32 users simultaneously share control over the port. 
Input from the users is placed in a queue and executed 
chronologically. Users should take advantage of the 
Message Board feature, which allows a user to take control 
of the keyboard and mouse or keyboard, mouse, and video 
of a Share port (see The Message Board, page 86).
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Timeout
The Timeout setting applies to ports with the Occupy I/O attribute. It controls 
the amount of time (0-255 seconds) that elapses before an inactive user is timed 
out when other users are waiting to take control of the port. Once the first user 
becomes inactive (i.e. stops sending keyboard and mouse input), it begins to 
countdown the amount of time specified in the Timeout field. If the user does 
not send input before the time expires, that user is timed out and the port is 
released. The next user to send mouse or keyboard input gains control of the 
port.

To apply Timeout settings:

1. Click Attributes... on the Customization dialog box. The Setting I/O 
Attributes dialog box appears (see Attributes, page 50).

2. In the Timeout field, enter the Timeout time in seconds.

3. Click Apply. (To exit without saving your changes, click Cancel.)

Note: The Timeout setting applies to all ports on the KN9108 / KN9116.
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Miscellaneous
The functions performed by the remaining elements at the bottom of the screen 
are described in the table below:

Item Description

Reset on exit Placing a check here causes the KN9108 / KN9116 to reset 
itself and implement all the new changes when you log out. 
Following the reset, wait approximately 30 to 60 seconds 
before logging back in. For example, if you change the IP 
address in the Network dialog box, you must open this page 
and enable Reset on exit before logging out. Otherwise, the 
change will not take effect.

Reset Values Clicking this button undoes all changes that have been made 
to the Configuration and Administration pages (except for port 
names, usernames, and passwords) and returns the 
parameters to the original factory default settings (see OSD 
Factory Default Settings, page 136).

Clear Name List This function clears the Port Names on the Main page.
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Date/Time

Note: Only the Local Console OSD has the Date/Time function. The Web 
browser versions do not.

The Date/Time dialog box lets the Administrator set up the KN9108 / 
KN9116's time parameters:

If your country or region employs Daylight Saving Time (Summer Time), 
check the corresponding box.
To establish the time zone that the KN9108 / KN9116 is located in, drop 
down the Time Zone list and choose the city that most closely corresponds 
to where it is at.
To set the year and day, use the Calendar graphic.

Clicking << or >> moves you backward or forward by one year 
increments.
Clicking < or > moves you backward or forward by one month 
increments.
In the calendar, click on the day.

To set the time, use the 24 hour HH:MM:SS format.
Click Synchronize to save your settings.
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The Log Page

Note: Only the Local Console OSD has the Log tab. The Web browser and AP 
versions do not. However, the log can be access through the browser via 
the Log icon. See Web Page Icons, page 57. 

Clicking the Log tab brings up the contents of the log file. The log file is 
discussed in Chapter 7, The Log File, page 97.
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Chapter 5
Browser Operation

Overview

After you have successfully logged in (see Logging In, page 15), the KN9108 
/ KN9116 Main Web page appears. All of the features are described in the 
sections that follow.

Main Web Page

The Main Web page appears with the General dialog box displayed:

Note: 1. This is the same dialog box that appears whenever you click the 
General icon at the top left of the page.

2. This screen depicts an Administrator’s page. Depending on a user’s 
type and permissions, not all of these elements appear.

3. When logging in from the Local Console, the Maintenance and PON 
icons do not appear.
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Web Page Layout

There are four icons at the top of the web page: General; Sync; Maintenance; 
and Logout, as follows:

The General Dialog Box

An explanation of the General dialog box fields is given in the table below:

Note: New versions of the KN9108 / KN9116's firmware can be downloaded 
from our website as they become available. See Upgrading the 
Firmware, page 58, for details.

Field Purpose

Device Name To make it easier to manage installations that have more than 
one KN9108 / KN9116

MAC Address The KN9108 / KN9116's MAC Address displays here.

Firmware Version Indicates the KN9108 / KN9116's current firmware version level.

Network Transfer 
Rate

This displays the rate at which the KN9108 / KN9116 transfers 
data between the switch and the client computers. The range is 
from 4–99999 Kilobytes per second (KBps). See Network 
Transfer Rate, page 41 for details.

Reset on exit To save any configuration/administration changes that you have 
made in the KN9108 / KN9116's OSD, place a check here to 
have the KN9108 / KN9116 implement the changes you have 
made and reset itself when you log out.
Note: This checkbox is only enabled for users who have 
administration privileges.

Last IP from DHCP 
server

Displays the current IP address of the KN9108 / KN9116.
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Web Page Icons
The purpose of the other icons at the top of the web page are explained in the 
table below:

Icon Function

Click this icon to synchronize the KN9108 / KN9116's time 
with your computer's time.

If both are in the same time zone, the device's time is 
changed to match the computer's time.

If they are in different time zones, the device's time is 
changed to match the computer's time, except that the 
time zone difference is still maintained.

Click this icon to install new versions of the KN9108 / 
KN9116's firmware (See Upgrading the Firmware, page 58, 
for details), or download your own private encryption key 
and private CA (See Private Certificate, page 59, for details)
Note: The Maintenance icon only displays for users with 
administrative permission. It doesn't appear on the web 
pages of users who don't have the proper permission.

You should always click this icon to log out and end your 
KN9108 / KN9116 session. If you close the browser without 
first logging out, you will have to wait approximately one 
minute before logging in again.
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Maintenance

The Maintenance page allows the Administrator to upgrade the KN9108 / 
KN9116’s firmware, and to download a private encryption key and signed 
certificate.

Upgrading the Firmware
As new versions of the KN9108 / KN9116 firmware become available, they 
can be downloaded from our website.

Note: Although upgrading the firmware isn't on the OSD Administration 
page, it is an administrative function, so we will discuss it in this 
chapter.

To upgrade the firmware, do the following:

1. Download the new firmware file to a computer that is not part of your 
KN9108 / KN9116 installation. 

2. From that computer, open your browser and log in to the KN9108 / 
KN9116 (see Logging In, page 15).

3. Click the Maintenance icon (see page 55) to open the Firmware 
configuration dialog box:

4. Click Browse; navigate to the directory that the new firmware file is in 
and select the file.

5. Click Upgrade.

6. After the upload completes, click the Logout icon to exit and reset the 
KN9108 / KN9116.
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Private Certificate
When logging in over a secure (SSL) connection, a signed certificate is used to 
verify that the user is logging in to the intended site. For enhanced security, the 
Private Certificate section allows you to use your own private encryption key 
and signed certificate, rather than the default ATEN certificate.

To do this, click the Maintenance icon (see page 55) to open the Private 
Certificate dialog box:

There are two methods for establishing your private certificate: generating a 
self-signed certificate; and importing a third-party certificate authority (CA) 
signed certificate.

Generating a Self-Signed Certificate
If you wish to create your own self-signed certificate, a free utility – 
openssl.exe – is available for download over the web. See Self-Signed Private 
Certificates, page 133 for details about using OpenSSL to generate your own 
private key and SSL certificate.

Obtaining a CA Signed SSL Server Certificate
For the greatest security, we recommend using a third party certificate 
authority (CA) signed certificate. To obtain a third party signed certificate, go 
to a CA (Certificate Authority) website to apply for an SSL certificate. After 
the CA sends the certificate, save it to a convenient location on your computer.

Importing the Private Certificate
To import the private certificate, do the following:

1. Click Browse to the right of Private Key; browse to where your private 
encryption key file is located; and select it.

2. Click Browse to the right of Certificate; browse to where your certificate 
file is located; and select it.

3. Click Upload to complete the procedure.

Note: Both the private encryption key and the signed certificate must be 
changed at the same time.



KN9108 / KN9116 User Manual

60

Web Page Buttons
The purpose of the buttons at the left of the web page are explained in the table 
below:

Icon Purpose

Click this button to open the WinClient ActiveX Viewer 
software to remotely control the KN9108 / KN9116 and the 
devices connected to it. See Activating the WinClient 
ActiveX Viewer, page 61.

For platform independence, the Java client allows users that 
have Java installed to connect to the KN9108 / KN9116. 
Click this button to open the Java Applet Viewer software to 
remotely control the KN9108 / KN9116 and the devices 
connected to it. See Activating the Java Applet Viewer, 
page 62

In some instances, administrators don't want the KN9108 / 
KN9116 to be accessible by browser. Clicking this button 
allows the user to download the AP version of the Windows 
Client. Once a user has downloaded the AP program, the 
administrator can turn off browser access. 

In some instances, administrators don't want the KN9108 / 
KN9116 to be accessible by browser. Clicking this button 
allows the user to download the AP version of the Java 
Client. Once a user has downloaded the AP program, the 
administrator can turn off browser access. 

Clicking this button allows the administrator to download 
and install the Log Server application. See The Log Server, 
page 99 for Log Server details.

If a Power on the NET™ (PON) module is connected to the 
KN9108 / KN9116, clicking this button brings up it's 
interface.

All the events that take place on the KN9108 / KN9116 are 
recorded in a log file. Clicking this icon displays the contents 
of the log file. See The Log File, page 97.
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Activating the WinClient ActiveX Viewer

After you have successfully logged in (see Browser Login, page 16), to activate 
the browser-based WinClient ActiveX Viewer do the following:

1. Click the Windows Client button (the one without the arrow) at the left of 
the web page.

Note: 1. You must have DirectX 8.0 or higher installed on your computer. 
If not, the WinClient ActiveX Viewer will not load. If you don't 
already have it, DirectX is available for free download from 
Microsoft's website: http://www.microsoft.com/downloads.

2. The Windows Client button with the arrow is for running the AP 
version of the Windows Client.

2. Accept the security certificates.

3. When you bring up the OSD, the Main Screen comes up in the center of 
your monitor. Turn to The Main Page, page 63, for further information
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Activating the Java Applet Viewer

After you have successfully logged in (see page 16), to activate the Java Applet 
Viewer, do the following:

1. Click the Java Client button (the one without the arrow) at the left of the 
web page.

Note: You must have the latest version of Sun's Java Runtime 
Environment (JRE) installed on your computer before running the 
Java Client. Java is available for free download from the Sun Java 
website: http://java.sun.com.

2. Accept the security certificates.

3. When you bring up the OSD, the Main Screen comes up in the center of 
your monitor. Turn to The Main Page, page 63, for further information
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Chapter 6
The User Interface

Overview
Once you have successfully logged in (see Logging In, page 15), activate the 
browser-based OSD. The look of the user interface main page varies slightly, 
depending on which method you used to log in (WinClient ActiveX Viewer, 
WinClient AP Control Panel, Java Applet Viewer, or Java Client AP Control 
Panel). The functions are described fully in the sections that follow.

The Main Page

The OSD comes up with the Main page displayed:

Note: 1. The Administration tab is disabled for users who don't have 
administration permission. For those who do have administration 
permission, administration operations are discussed in Chapter 4.

2. There is a small Control Panel that appears above the Main page when 
you mouse over the top toolbar. This is discussed in detail on page 72.

There are two buttons on the title bar at the top right. They are described below 
starting from the left and moving to the right:
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Log out: clicking this button (or pressing F8) closes the OSD display and 
logs you out of the KN9108 / KN9116 session.
Close: clicking this button closes the OSD display but does not log you out 
of the session. You can bring the display back with the OSD hotkeys (see 
OSD Hotkey, page 95).

Note: The Screen View and Transparent buttons are available on the Local 
Console OSD only (See page 25).

The Main Page lists all of the KN9108 / KN9116's ports. You access the 
computers connected to its ports by selecting them on this page.

Details regarding the meaning and operation of the main page elements are 
provided in Chapter 4, Administration.
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Port Operation

Select a port on the OSD Main Screen either by moving the highlight bar to it 
with the Up and Down Arrow keys and pressing Enter, or by double-clicking 
it. Once you select a port, its screen displays on you monitor, and your 
keyboard and mouse input affects the remote system.

The OSD Toolbar
The OSD provides a toolbar to help you control the KN9108 / KN9116 from 
within the captured port. Depending on which method you used to log in, the 
toolbar differs slightly (See note 2, below). To bring up the toolbar, tap the 
OSD Hotkey twice (Scroll Lock or Ctrl). The toolbar appears at the upper left 
corner of the screen:

Local OSD

Remote OSD

Depending on the settings that were selected under ID Display (see page 95), 
the Port Number and/or the Port Name display at the right of the toolbar.

Note: 1. When the toolbar displays, mouse input is confined to the toolbar area 
and keyboard input has no effect. To carry out operations on the 
computer connected to the port, close the toolbar by clicking the X on 
it; or, recall the OSD and select the port again.

2. The Local OSD toolbar exclusively has the Switch Opaque/
Transparent function; the Remote OSD toolbar exclusively has the 
Panel Array Mode function. See the icons in the table on the 
following page for details.

Recalling the OSD
To dismiss the toolbar and bring back the OSD display (the Main, 
Configuration, and Administration pages), do one of the following:

tap the OSD Hotkey once; 
or, from the toolbar click the icon that brings up the OSD (see page 66).

The OSD Toolbar closes, and the main OSD display reappears.
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OSD Hotkey Summary Table
The following table presents a summary of the OSD Hotkey actions. 
To set the OSD Hotkey, see OSD Hotkey, page 95.

The Toolbar Icons
The meanings of the toolbar icons are explained in the table below

Note: The administrator selects which ports are accessible to each user with 
the User Management function (see page 36 for details).

To... When... Do This...

Open the OSD 
Toolbar

The OSD Toolbar is not open. Click the OSD Hotkey twice.

Open the OSD The OSD Toolbar is open. Click the OSD Hotkey once.

Open the OSD The OSD Toolbar is not open. Click the OSD Hotkey three times.

Click to skip to the first accessible port on the entire installation without 
having to invoke the OSD.

Click to skip to the first accessible port previous to the current one without 
having to invoke the OSD.

Click to begin Auto Scan Mode. The KN9108 / KN9116 automatically 
switches among the ports that were selected for Auto Scanning under the 
Configuration Scan Select function (see Scan Select, page 95). This allows 
you to monitor their activity without having to switch among them manually.

Click to skip from the current port to the next accessible one without having 
to invoke the OSD.

Click to skip from the current port to the last accessible port on the entire 
installation without having to invoke the OSD.

Click to bring up the OSD.

Click to close the toolbar.

Click to logout and exit the WinClient ActiveX Viewer application.

Local OSD only: Click to switch toolbar to Transparent/Opaque Mode.

Remote OSD only: Click to invoke Panel Array Mode (see page 69).
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Hotkey Operation
Hotkeys allow you to provide KVM focus to a port directly from the keyboard. 
The KN9108 / KN9116 provides the following hotkey features:

Auto Scanning 
Skip Mode Switching

The hotkeys are: A and P for Auto Scanning; and the Arrow Keys for Skip 
Mode.

Note: 1. In order for hotkey operations to take place, the OSD Toolbar must be 
visible (see Port Operation, page 65). To use the keys designated as 
hotkeys (i.e. A, P, etc.) for normal, non-hotkey purposes, you must 
first close the toolbar.

2. For issues affecting multiple user operation in Auto Scan Mode, see 
Multiuser Operation, page 71.

Auto Scanning
The Auto Scan function automatically switches among all the ports that are 
accessible to the currently logged on User at regular intervals, so that the user 
can monitor their activity automatically. (See Scan Select, page 95, for 
information regarding accessible ports.)

Setting the Scan Interval
The amount of time Auto Scan dwells on each port is set with the Scan 
Duration setting (see page 95).

Invoking Auto Scan
To start Auto Scanning, tap the A key. The Auto Scan function cycles through 
the ports in order - starting from the first port on the installation. An S appears 
in front of the Port ID Display to indicate that the port is being accessed under 
Auto Scan Mode.
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Pausing Auto Scan
While you are in Auto Scan Mode, you can pause the scanning in order to keep 
the focus on a particular computer by pressing P. During the time that Auto 
Scanning is paused, the S in front of the Port ID blinks On and Off.

Pausing when you want to keep the focus on a particular computer is more 
convenient than Exiting Auto Scan Mode because when you Resume scanning, 
you start from where you left off. If, on the other hand, you were to exit and 
restart Auto Scan Mode, the scanning would start from the very first computer 
on the installation. To resume Auto Scanning, press any key except Esc or the 
Spacebar. Scanning continues from where it left off.

Exiting Auto Scan
While Auto Scan Mode is in effect, ordinary keyboard functions are 
suspended. You must exit Auto Scan Mode in order to regain normal control 
of the keyboard. To exit Auto Scan Mode press Esc or the Spacebar. Auto 
Scanning stops when you exit Auto Scan Mode.

Skip Mode
Skip Mode allows you to switch ports in order to monitor the computers 
manually. You can dwell on a particular port for as long or as little as you like 
- as opposed to Auto Scanning, which automatically switches after a fixed 
interval. The Skip Mode hotkeys are the four Arrow keys. Their operation is 
explained in the table below:

Arrow Action

← Skips from the current port to the first accessible port previous to it. 
(See Scan Select, page 95, for information regarding accessible ports.)

→ Skips from the current port to the first accessible port that comes after it.

↑ Skips from the current port to the very first accessible port on the 
installation.

↓ Skips from the current port to the very last accessible port on the 
installation.
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Panel Array Mode
Clicking on the OSD Toolbar's Panel icon invokes Panel Array Mode. Under 
this mode, the OSD divides your screen into a 4 x 4 grid of 16 panels:

Each panel represents one of the KN9108 / KN9116's ports. Starting with 
Port 1 at the upper left; going from left to right; top to bottom; Port 16 is at 
the lower right.
When the Array is first invoked, it scans through each of the ports that 
were selected for Auto Scanning under the Configuration page's Scan 
Select function (see page 95), and displays information about the port (port 
name, resolution, on line status, port access status), at the bottom of the 
panel.
The number of panels in the array (16, 9, 4, or 1) can be selected by 
clicking Show More Ports (+), and Show Fewer Ports (-) on the panel 
array toolbar. 
If the computer connected to a port is on line, its screen displays in its 
panel, otherwise the panel is blank.
Only ports that are accessible to the currently logged in user display (see 
Port Access, page 38). All other panels are blank.
If you move the mouse pointer over a panel, information about the port 
displays at the bottom of the screen.

(Continues on next page.)



KN9108 / KN9116 User Manual

70

(Continued from previous page.)
You can access a computer connected to a port by moving the mouse 
pointer over its panel and clicking. You switch to the computer exactly as 
if you had selected it from the OSD Main screen.
The panel array toolbar, at the lower right of the screen, provides shortcut 
navigation and control of the panel array as described in the diagram 
below:

For issues affecting multiple user operation in Panel Array Mode, see 
Multiuser Operation, page 71.

Click the pushpin to have the toolbar always be on top.

Pause panel scanning, leaving the focus on the panel that currently has it.

Move back four panels.

Move to the previous panel.

Move to the next panel.

Move ahead four panels.

Show More Ports: Increase the number of panels in the array.

Show Fewer Ports: Decrease the number of panels in the array.

Toggle 4/3 aspect ratio.

Exit Panel Array mode.
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Multiuser Operation
The KN9108 / KN9116 supports multiuser operation. Up to 32 users can log in 
at the same time. When multiple users simultaneously access the KN9108 / 
KN9116 switch from remote consoles, the rules of precedence that apply are 
shown in the following table:

Note: ATEN recommends that the user who starts Panel Array Mode set it to 
display at least four panels; otherwise, it is possible that other users may 
receive only part of the picture.

Operation Rule

General Once a user invokes the OSD, no other user can invoke it 
until the original user closes it.

Auto Scan Mode If a user has invoked Auto Scan Mode (see Auto Scanning, 
page 67), but the OSD has not been invoked, another user 
can interrupt Auto Scan Mode by invoking the OSD.

Panel Array Mode When a user has invoked Panel Array Mode (see page 69), 
all successive users automatically enter Panel Array Mode. 
Panel Array Mode continues until the original user stops it. 
(Administrators can override Panel Array Mode.)

Only the user who starts Panel Array Mode can use the Skip 
Mode (see page 68) function.

Only the user who starts Panel Array Mode can switch ports. 
Other users automatically switch to the ports that the original 
user selects. However, if an individual user does not have 
access rights to the port that the original user switches to, 
the user will not be able to view that port.

Individual users can increase or decrease the number of 
panels they wish to view in Panel Array Mode; however, the 
picture quality may decrease as the number of panels 
decreases.
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Control Panel

Since the WinClient ActiveX Viewer and WinClient AP Control Panel 
contains the most complete functionality of all the user interface control panels, 
this section describes the WinClient Control Panel. Although the other control 
panels may not have all of the features that this one does, you can refer to the 
information described here when using them.

The control panel consists of an icon bar at the top, with two text bars below it; 
as shown:

Note: The above image shows the complete Control Panel. The icons that 
appear can be customized. See Control Panel Configuration, page 91, 
for details.

By default, the top text row shows the video resolution of the remote 
display. As the mouse pointer moves over the icons in the icon bar, 
however, the information in the top text row changes to describe the icon's 
function. In addition, if a message from another user is entered in the 
message board, and you have not opened the message board in your 
session, the message will appear in the top row.
The lower row shows the IP address of the device you are accessing at the 
left. In the center of the bar, the number before the slash indicates which 
bus the user is on, while the number behind the slash indicates the number 
of users on that bus.

(Continues on next page.)
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(Continued from previous page.)
Right clicking in the text row area brings up a menu that allows you to 
select options for the Screen Mode, Zoom and Macro List. These functions 
are discussed in the sections that follow.

To move the Control Panel to a different location on the screen, place the 
mouse pointer over the text bar area, then click and drag.
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Control Panel Functions

(Continues on next page.)

Icon Function

This is a toggle. Click to make the Control Panel persistent – 
i.e., it always displays on top of other screen elements. Click 
again to have it display normally.

Click to bring up the Macros dialog box (see page 76 for 
details).

Click to bring up the Video Options dialog box. Right-click to 
perform a quick Auto Sync (see Video Settings, page 82, for 
details).

Toggles the display between Full Screen Mode and Windowed 
Mode.

Click to take a snapshot (screen capture) of the remote 
display. See Snapshot, page 92, for details on configuring the 
Snapshot parameters.

Click to bring up the Message Board (see The Message 
Board, page 86).

Click to send a Ctrl+Alt+Del signal to the remote system.

Click to bring up the on-screen keyboard (see The On-Screen 
Keyboard, page 89).

Click to display a dropdown Macro List of User macros. 
Access and run macros more conveniently rather than using 
the Macros dialog box (see the Macros icon in the table above, 
and the Macros section on page 76).

Click to bring up the Control Panel Configuration dialog box. 
See Control Panel Configuration, page 91, for details on 
configuring the Control Panel.

Click to exit the remote view.
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(Continued from previous page.)

The Hotkey Setup, Video Options and Message Board functions are discussed 
in the sections that follow.

These icons show the Num Lock, Caps Lock, and Scroll Lock 
status of the remote computer.

When the lock state is On, the LED is bright green and the 
lock hasp is closed.

When the lock state is Off, the LED is dull green and the lock 
hasp is open.

Click on the icon to toggle the status.
Note: These icons and your local keyboard icons are in sync. 
Clicking an icon causes the corresponding LED on your 
keyboard to change accordingly. Likewise, pressing a Lock key 
on your keyboard causes the icon’s color to change 
accordingly.
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Macros
The Macros icon provides access to two functions found in the Macros dialog 
box: Hotkeys and User Macros. Both are described in the following sections.

Note: The T button at the top right of the dialog boxes that appear for the 
Macros function brings up a slider to adjust the transparency of the 
dialog box. After making your adjustment, click anywhere in the dialog 
box to dismiss the slider.

Hotkeys
Various actions, corresponding to clicking the Control Panel icons, can be 
accomplished directly from the keyboard with hotkeys. Selecting the Hotkeys 
radio button lets you configure which hotkeys perform the actions.The actions 
are listed to the left; their hotkeys are shown to the right. Use the checkbox to 
the left of an action’s name to enable or disable its hotkey.

If you find the default Hotkey combinations inconvenient, you can reconfigure 
them as follows:

1. Highlight an Action, then click Set Hotkey.

2. Press your selected Function keys (one at a time). The key names appear in 
the Hotkeys field as you press them.

You can use the same function keys for more than one action, as long 
as the key sequence is not the same.
To cancel setting a hotkey value, click Cancel; to clear an action’s 
Hotkeys field, click Clear.

3. When you have finished keying in your sequence, click Save.

To reset all the hotkeys to their default values, click Reset.
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An explanation of the Hotkey actions is given in the table below:

Search
Search, at the bottom of the dialog box, lets you filter the list of macros that 
appear in the large upper panel for you to play or edit. Click a radio button to 
choose whether you want to search by name or by Hotkey; key in a string for 
the search; then click Search. All instances that match your search string 
appear in the upper panel.

Action Explanation

Exit remote 
location

If you are using the Java AP, this exits the remote view and goes back to 
the web browser Main Page. If you are using the WinClient AP, this exits 
remote view and goes back to the WinClient main page. This is equivalent 
to clicking the Exit icon on the Control Panel. The default keys are F2, F3, 
F4.

Adjust Video Brings up the Video Settings dialog box. This is equivalent to clicking the 
Video Settings icon on the Control Panel. The default keys are F5, F6, F7.

Toggle OSD Toggles the Control Panel Off and On. The default keys are F3, F4, F5.

Toggle mouse 
display

If you find the display of the two mouse pointers (local and remote) to be 
confusing or annoying, you can use this function to shrink the non-
functioning pointer down to a barely noticeable tiny circle, which can be 
ignored. Since this function is a toggle, use the hotkeys again to bring the 
mouse display back to its original configuration. This is equivalent to 
selecting the Dot pointer type from the Mouse Pointer icon on the Control 
Panel. The default keys are F7, F8, F9.
Note: The Java Control Panel does not have this feature.

Adjust mouse This synchronizes the local and remote mouse movements. The default 
keys are F8, F7, F9.

Video Auto-
sync

This combination performs an auto-sync operation. It is equivalent to 
clicking the Video Autosync icon on the Control Panel. The default keys are 
F6, F7, F8.

Show/Hide 
Local Cursor

Toggles the display of your local mouse pointer off and on. This is 
equivalent to selecting the Null pointer type from the Mouse Pointer icon on 
the Control Panel. The default keys are F4,F5.

Substitute Ctrl 
key

If your local computer captures Ctrl key combinations, preventing them from 
being sent to the remote system, you can implement their effects on the 
remote system by specifying a function key to substitute for the Ctrl key. If 
you substitute the F11 key, for example, pressing [F11 + 5] would appear to 
the remote system as [Ctrl + 5]. The default key is F11.

Substitute Alt 
key

Although all other keyboard input is captured and sent to the remote 
system, [Alt + Tab] and [Ctrl + Alt + Del] work on your local computer. In 
order to implement their effects on the remote system, another key may be 
substituted for the Alt key. If you substitute the F12 key, for example, you 
would use [F12 + Tab] and [Ctrl + F12 + Del]. The default key is F12.
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User Macros
User Macros are used to perform specific actions on the remote server. To 
create the macro, do the following:

1. Select User Macros radio button, then click Add.

2. In the dialog box that comes up, replace the “New Macro” text with a 
name of your choice for the macro:
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3. Click Record.
The dialog box disappears, and a small panel appears at the top left of the 
screen:

4. Press the keys for the macro.
To pause macro recording, click Pause. To resume, click Pause again.
Clicking Show brings up a dialog box that lists each keystroke that you 
make, together with the amount of time each one takes:

Clicking Cancel cancels all keystrokes.
When you have finished, click Stop. This is the equivalent of clicking 
Done in Step 5.

Note: 1. Case is not considered – typing A or a has the same effect.

2. When recording the macro the focus must be on the remote screen. It 
cannot be in the macro dialog box.

3. Only the default keyboard characters may be used. Alternate 
characters cannot be used. For example, if the keyboard is Traditional 
Chinese and default character is A the alternate Chinese character 
obtained via keyboard switching is not recorded.
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5. If you haven’t brought up the Show dialog, click Done when you have 
finished recording your macro. You return to the Macros dialog box with 
your system macro key presses displayed in the Macro column:

6. If you want to change any of the keystrokes, select the macro and click 
Edit. This brings up a dialog box similar to the one for Show. You can 
change the content of your keystrokes, change their order, etc.

7. Repeat the procedure for any other macros you wish to create.
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After creating your macros, you can run them either by opening this dialog box 
and clicking Play, or by opening the Macro List on the Control Panel and 
clicking the one you want.

If you run the macro from this dialog box, 
you have the option of specifying how the 
macro runs, by clicking the arrow next to the 
Play button.

If you choose Play Without Wait, the macro runs the keypresses one after 
another with no time delay between them.
If you choose Play With Time Control, the macro waits for the amount of 
time between key presses that you took when you created it. Click on the 
arrow next to Play to make your choice.
If you click Play without opening the list, the macro runs with the default 
choice. The default choice (NoWait or TimeCtrl), is shown in the Playback 
column.

You can change the default choice by clicking on the current choice 
(NoWait in the screenshot shown), and selecting the alternative choice.

Note: 1. Information about the Search function is given on page 77.

2. User Macros are stored on the Local Client computer of each user. 
Therefore there is no limitation on the of number of macros, the size 
of the macro names, or makeup of the hotkey combinations that 
invoke them
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Video Settings
Clicking the Hammer icon on the Control Panel brings up the Video Settings 
dialog box. The options in this dialog box allow you to adjust the placement 
and picture quality of the remote screen on your monitor

The meanings of the video adjustment options are given in the table on the 
following two pages:
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Video adjustment options:

Options Usage

Screen Position Adjust the horizontal and vertical position of the remote server 
window by Clicking the Arrow buttons.

Auto-Sync Click Auto-Sync to have the vertical and horizontal offset values of 
the remote screen detected and automatically synchronized with the 
local screen.
Note: 1. If the local and remote mouse pointers are out of sync, in 

most cases, performing this function will bring them back 
into sync.

2. This function works best with a bright screen.
3. If you are not satisfied with the results, use the Screen 

Position arrows to position the remote display manually.

RGB Drag the slider bars to adjust the RGB (Red, Green, Blue) values. 
When an RGB value is increased, the RGB component of the image 
is correspondingly increased.
If you enable Set to Grayscale, the remote video display is changed 
to grayscale.

Gamma This section allows you to adjust the video display's gamma level. 
This function is discussed in detail in the next section, Gamma 
Adjustment.

Network Type Select the type of internet connection that the local client computer 
uses. The switch will use that selection to automatically adjust the 
Video Quality and Detect Tolerance settings to optimize the quality of 
the video display.
Since network conditions vary, if none of the pre-set choices seem to 
work well, you can select Customize and use the Video Quality and 
Detect Tolerance slider bars to adjust the settings to suit your 
conditions.

Video Quality Drag the slider bar to adjust the overall Video Quality. The larger the 
value, the clearer the picture and the more video data goes through 
the network. Depending on the network bandwidth, a high value may 
adversely effect response time.
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Enable Refresh The KN9108 / KN9116 can redraw the screen every 1 to 99 seconds, 
eliminating unwanted artifacts from the screen. Select Enable 
Refresh and enter a number from 1 through 99. The KN9108 / 
KN9116 will redraw the screen at the interval you specify. This 
feature is disabled by default. Click to put a check mark in the box 
next to Enable Refresh to enable this feature.
Note: 1. The switch starts counting the time interval when mouse 

movement stops.
2. Enabling this feature increases the volume of video data 

transmitted over the network. The lower the number 
specified, the more often the video data is transmitted. 
Setting too low a value may adversely affect overall 
operating responsiveness.

Transparency Adjusts the transparency of the Control Panel and other Toolbars. 
Slide the bar until the display in the example window is to your liking.

Color Depth 
Control

This setting determines the richness of the video display by adjusting 
the amount of color information.
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Gamma Adjustment
If it is necessary to correct the gamma level for the remote video display, use 
the Gamma function of the Video Adjustment dialog box.

Under Basic configuration, there are ten preset and four user-defined levels 
to choose from. Drop down the list box and choose the most suitable one.
For greater control, clicking the Advanced button brings up the following 
dialog box:

Click and drag the diagonal line at as many points as you wish to achieve 
the display output you desire.
Click Save As to save up to four user-defined configurations derived from 
this method. Saved configurations can be recalled from the list box at a 
future time.
Click Reset to abandon any changes and return the gamma line to its 
original diagonal position.
Click OK to save your changes and close the dialog box.
Click Cancel to abandon your changes and close the dialog box.

Note: For best results, change the gamma while viewing a remote server.
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The Message Board
The KN9108 / KN9116 supports multiple user logins, which can possibly give 
rise to access conflicts. To alleviate this problem, a message board feature has 
been provided, allowing users to communicate with each other.

The message board functions much like an Internet chat program does. When 
you click the Message Board icon on the Control Panel (see page 72), a screen 
similar to the one below appears:
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The Button Bar
The buttons on the Button Bar are toggles. Their actions are described in the 
table below:

Message Display Panel
Messages that users post to the board - as well as system messages - display in 
this panel. If you disable Chat, however, messages that get posted to the board 
won't appear.

Compose Panel
Key in the messages that you want to post to the board in this panel. Click 
Send, or press [Enter] to post the message to the board.

Button Action

Enable/Disable Chat. When disabled, messages posted to the board 
are not displayed. The button is shadowed when Chat is disabled. The 
icon displays next to the user's name in the User List panel when the 
user has disabled Chat.

Occupy/Release Keyboard/Video/Mouse. When you Occupy the 
KVM, other users cannot see the video, and cannot input keyboard or 
mouse data. The button is shadowed when the KVM is occupied. The 
icon displays next to the user's name in the User List panel when the 
user has occupied the KVM.

Occupy/Release Keyboard/Mouse. When you Occupy the KM, other 
users can see the video, but cannot input keyboard or mouse data. 
The button is shadowed when the KM is occupied. The icon displays 
next to the user's name in the User List panel when the user has 
occupied the KM.

Show/Hide User List. When you Hide the User List, the User List panel 
closes. The button is shadowed when the User List is open.
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User List Panel
The names of all the logged in users are listed in this panel.

Your name appears in blue; other users' names appear in black.
By default, messages are posted to all users. To post a message to one 
individual user, select the user's name before sending your message.
If a user's name is selected, and you want to post a message to all users, 
select All Users before sending your message.
If a user has disabled Chat, its icon displays before the user's name to 
indicate so.
If a user has occupied the KVM or the KM, its icon displays before the 
user's name to indicate so.



 Chapter 6. The User Interface

89

The On-Screen Keyboard
The KN9108 / KN9116 supports an on-screen keyboard, available in multiple 
languages, with all the standard keys for each supported language. Click this 
icon to pop up the on-screen keyboard:

One of the major advantages of the on-screen keyboard is that if the keyboard 
languages of the remote and local systems aren’t the same, you don’t have to 
change the configuration settings for either system. The user just has to bring 
up the on-screen keyboard; select the language used by the server on the port 
he is accessing; and use the on-screen keyboard to communicate with it.

Note: You must use your mouse to click on the keys. You cannot use your 
actual keyboard.

To change languages, do the following:

1. Click the down arrow next to the currently selected language, to drop 
down the language list.

2. Select the new language from the list.
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To display/hide the expanded keyboard keys, click the arrow to the right of the 
language list arrow.
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Control Panel Configuration
Clicking the Control Panel icon brings up a dialog box that allows you to 
configure the items that appear on the Control Panel, as well as its graphical 
settings. The dialog box differs slightly, depending on whether you use the 
WinClient ActiveX Viewer or the Java Applet Viewer:

WinClient ActiveX

Java Applet

(Continues on next page.)
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The dialog box is organized into six main sections as described, below:

Note: The WinClient ActiveX Viewer has three functions that the Java Applet 
Viewer does not: Transparent; Screen Options; and Keyboard Pass 
Through.

Item Description

Control Panel Allows you to customize the Control Panel by selecting which icons display 
in the Control Panel

Control Panel 
Style

WinClient ActiveX Viewer only: Enabling Transparent makes the Control 
Panel semi-transparent, so that you can see through it to the display 
underneath.
Enabling Icon causes the Control Panel to display as an icon until you 
mouse over it. When you mouse over the icon, the full panel comes up.

Screen 
Options

WinClient ActiveX Viewer only:
If Full Screen Mode is enabled, the remote display fills the entire screen.
If Full Screen Mode is not enabled, the remote display appears as a 
window on the local desktop. If the remote screen is larger than what is 
able to fit in the window, move the mouse pointer to the screen border 
that is closest to the area you want to view and the screen will scroll.
If Keep Screen Size is enabled, the remote screen is not resized.

If the remote resolution is smaller than that of the local monitor, its 
display appears like a window centered on the screen.

If the remote resolution is larger than that of the local monitor, its 
display is centered on the screen. To access the areas that are off 
screen, move the mouse to the corner of the screen that is closest to 
the area you want to view and the screen will scroll.

If Keep Screen Size is not enabled, the remote screen is resized to fit the 
local monitor's resolution.

Bus Info If Bus Info is enabled, the number of the bus you are on, as well as the total 
number of users on the bus, displays on the bottom row center of the 
Control Panel as follows: Bus No./Total Users.

Snapshot These settings let the user configure the KN9108 / KN9116’s screen 
capture parameters (see the Snapshot description under Control Panel, 
page 72):

Path lets you select a directory that the captured screens automatically 
get saved to. Click Browse; navigate to the directory of your choice; then 
click OK. If you don’t specify a directory here, the snapshot is saved to 
your desktop.
Click a radio button to choose whether you want the captured screen to 
be saved as a BMP or a JPEG (JPG) file.
If you choose JPEG, you can select the quality of the captured file with 
the slider bar. The higher the quality, the better looking the image, but the 
larger the file size.

Note: The Java Applet Viewer supports PNG not BMP files.

Keyboard Pass 
Through

WinClient ActiveX Viewer Only: When this is enabled, the Alt-Tab key press 
is passed to the remote server and affect that server. If it is not enabled, Alt-
Tab acts on your local client computer.
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Mouse Synchronization
Until you close the KN9108 / KN9116 connection, mouse movements have no 
effect on your local system, but instead are captured and sent to the remote 
system.

From time to time, especially if you change video resolution, the local mouse 
movement may no longer be synchronized with the remote system's mouse 
pointer. There are three quick methods that can be used to bring the two 
pointers back into sync:

Right-clicking on the hammer icon in the WinClient ActiveX Viewer 
Control Panel.
Moving the mouse pointer into the Control Panel and back out again.
Performing an Auto Sync with the Video Adjustment function (see Video 
Settings, page 82, for details).

If performing these actions does not resolve the problem, do the following:

1. Invoke the Adjust Mouse function with the Adjust Mouse hotkeys (see 
Hotkey Operation, page 67, for details).

2. Move the local mouse pointer exactly on top of the remote mouse pointer 
and click.

If this procedure still does not help, you should set the mouse speed and 
acceleration for each problematic computer attached to the switch. 
See Additional Mouse Synchronization Procedures, page 131, for instructions.



KN9108 / KN9116 User Manual

94

The Configuration Page

The OSD Configuration page allows users to set up their own, individual, 
working environments. The KN9108 / KN9116 stores a separate configuration 
record for each user profile, and sets up the working configuration according 
to the Username that is used to log in.
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The Configuration page settings are explained in the following table:

Setting Function

OSD Hotkey Selects which Hotkey controls the OSD function: [Scroll Lock] 
[Scroll Lock] or [Ctrl] [Ctrl]. Since the Ctrl key combination may 
conflict with programs running on the computers, the default is the 
Scroll Lock combination. (See p. 67 for Hotkey operation.)

ID Display Selects how the Port ID is displayed: the Port Number alone 
(PORT NUMBER); the Port Name alone (PORT NAME); or the 
Port Number plus the Port Name (PORT NUMBER + PORT 
NAME). The default is PORT NUMBER + PORT NAME.

ID Duration Determines how long a Port ID displays on the monitor after a port 
change has taken place. You can choose an amount from 0 - 255 
seconds. The default is 5 Seconds. Enable the Always On radio 
button for the Port ID to be always on.

Scan Select Selects which computers will be accessed under Auto Scan Mode 
(see Auto Scanning, page 67). Choices are: ALL - All the Ports 
which have been set Accessible (see Port Access, page 38); 
POWERED ON - Only those Ports which have been set Accessible 
and are Powered On; QUICK VIEW - Only those Ports which have 
been set Accessible and have been selected as Quick View Ports 
(see Quick View Ports, page 27); QUICK VIEW + POWERED ON - 
Only those Ports which have been set Accessible and have been 
selected as Quick View Ports and are Powered On. The default is 
ALL.

Scan Duration Determines how long the focus dwells on each port as it cycles 
through the selected ports in Auto Scan Mode (see Auto Scanning, 
page 67). Key in a value from 0 - 255 seconds. The default is 10 
seconds; a setting of 0 disables the Scan function.

Screen Blanker If there is no input from the console for the amount of time set with 
this function, the screen is blanked. Key in a value from 1 - 30 
minutes. A setting of 0 disables this function. The default is 0 
(disabled).

Logout Timeout If there is no Operator input for the amount of time set with this 
function, the Operator is automatically logged out. A login is 
necessary before the KN9108 / KN9116 can be accessed again. 
Enter a value from 0 - 180 minutes. The default is 30 minutes. 0 
disables the function.

Beeper When set to ON, the beeper sounds whenever the port is switched, 
when activating the Auto Scan function (see Auto Scanning, 
page 67), or when an invalid entry is made on an OSD menu. The 
default is ON.

Change 
Password

Allows a user to change the account password. After clicking the 
Change Password button, a dialog box appears. Enter the old 
password. Then, enter a new password and confirm it by entering it 
again. Press OK to save changes, or press Cancel to discard 
changes.
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Chapter 7
The Log File

The Main Screen

The KN9108 / KN9116 logs all the events that take place on it. To view the 
contents of the log file, click the Log icon at the left of the web page. A screen 
similar to the one below appears:

A maximum of 512 events are stored in the log file. To clear the log file, click 
on the Clear Log icon at the right of the screen.

Note: The Log File is a temporary file that is erased when the KN9108 / 
KN9116 is turned off or loses power. It is recommended that you install 
the Log Server to backup the contents of the log file.
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Chapter 8
The Log Server

The Windows-based Log Server is an administrative utility that records all the 
events that take place on selected KN9108 / KN9116 units and writes them to 
a searchable database. This chapter describes how to install and configure the 
Log Server.

Installation

1. From the computer that you want to use as the Log Server, open your 
browser and log into the KN9108 / KN9116 (see page 15).

2. Click the Log Server button at the left of the web page to start the Log 
Server installation program.

3. If any security warning dialog boxes appear, ignore them and click Run or 
Open.

Note: If the browser cannot run the file, save it to disk, instead, and run the 
file from your disk.

The Log Server Setup screen comes up:

4. Click Next. Then follow the on-screen instructions to complete the 
installation and have the Log Server program icon placed on your desktop.
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Starting Up

To bring up the Log Server, either double click the program icon, or key in the 
full path to the program on the command line. The first time you run it, a screen 
similar to the one below appears:

Note: 1. The MAC address of the Log Server computer must be specified on 
the Service Configuration page of the Administrator Utility 
(see page 39).

2. The Log Server requires the Microsoft Jet OLEDB 4.0 driver in order 
to access the database.

The screen is divided into three components:
A Menu Bar at the top
A panel for a list of KN9108 / KN9116 units in the middle (see Overview, 
page 105).
A panel for an Events List at the bottom (see Overview, page 105).

Each of the components is explained in the sections that follow.
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The Menu Bar

The Menu bar consists of four items: 
Configure
Events
Options
Help

These are discussed in the sections that follow.

Note: If the Menu Bar appears to be disabled, click in the KN9108 / KN9116 
List window to enable it.

Configure
The Configure menu contains three items: Add, Edit, and Delete. They are used 
to add new KN9108 / KN9116 units to the KN9108 / KN9116 List, edit the 
information for units already on the list, or delete KN9108 / KN9116 units from 
the list.

To add a KN9108 / KN9116 to the KN9108 / KN9116 List, click Add.
To edit or delete a listed KN9108 / KN9116, first select the one you want 
in the KN9108 / KN9116 List window, then open this menu and click Edit 
or Delete.

When you choose Add or Edit, a dialog box, similar to the one below appears:
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A description of the fields is given in the table, below:

Fill in or modify the fields, then click OK to finish.

Events
The Events Menu has two items: Search and Maintenance.

Search
Search allows you to search for events containing specific words or strings. 
When you access this function, a screen similar to the one below appears:

Field Explanation

Address This can either be the IP address of the KN9108 / KN9116 or its DNS 
name (if the network administrator has assigned it a DNS name).

Port The Port number assigned to the KN9108 / KN9116 (see Log Server, 
page 40).

Description This field is provided so that you can put in a descriptive reference for 
the unit to help identify it.

Limit This specifies the number of days that an event should be kept in the 
Log Server's database before it expires and it is cleared out.
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A description of the items is given in the table below:

Item Explanation

New search This is one of three radio buttons that define the scope of the 
search. If it is selected, the search is performed on all the 
events in the database for the selected KN9108 / KN9116.

Search last results This is a secondary search performed on the events that 
resulted from the last search.

Search excluding last 
results

This is a secondary search performed on all the events in the 
database for the selected KN9108 / KN9116 excluding the 
events that resulted from the last search.

Server List KN9108 / KN9116 units are listed according to their IP 
address. Select the unit that you want to perform the search 
on from this list. You can select more than one unit for the 
search. If no units are selected, the search is performed on all 
of them.

Priority List Sets the level for how detailed the search results display 
should be. 1 is the most general; 3 is the most specific.

Start Date Select the date that you want the search to start from. The 
format follows the YY/MM/DD convention, as follows:
2005/11/04

Start Time Select the time that you want the search to start from.

End Date Select the date that you want the search to end at.

End Time Select the time that you want the search to end at.

Pattern Key in the pattern that you are searching for here. The 
multiple character wildcard (%) is supported. E.g., h%ds 
would match hands and hoods.

Results Lists the events that contained matches for the search.

Search Click this button to start the search.

Print Click this button to print the search results.

Export Click this button to export the search results.

Exit Click this button to exit the Search dialog box.
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Maintenance
This function allows the administrator to perform manual maintenance of the 
database. He can use it to erase specified records before the expiration time that 
was set with the Limit setting of the Edit function (see page 102).

Options
Network Retry allows you to set the number of seconds that the Log Server 
should wait before attempting to connect if the previous attempt to connect 
failed. When you click this item, a dialog box, similar to the one below appears:

Key in the number of seconds, then click OK to finish.

Help
From the Help Menu, click Contents to access the online Windows Help file. 
The help file contains instructions about how to setup, operation and 
troubleshoot the Log Server.
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The Log Server Main Screen

Overview
The Log Server Main Screen is divided into two main panels. 

The upper (List) panel lists the KN9108 / KN9116 units that have been 
selected for the Log Server to track (see Configure, page 101).
 The lower (Event) panel displays the log events for the currently selected 
KN9108 / KN9116 (the highlighted one - if there are more than one). To 
select a KN9108 / KN9116 unit in the list, simply click on it.
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The List Panel
The List panel contains six fields:

The Event Panel
The lower panel displays log events for the currently selected KN9108 / 
KN9116. Note that if there are more than one KN9108 / KN9116 units, even 
though they aren't currently selected, if their Recording checkbox is checked, 
the Log Server records their log events and keeps them in its database.

Field Explanation

Recording Determines whether the Log Server records log events for 
this KN9108 / KN9116 or not. If the Recording checkbox is 
checked, the field displays Recording, and log events are 
recorded. If the Recording checkbox is not checked, the field 
displays Paused, and log events are not recorded.
Note: Even though a KN9108 / KN9116 is not the currently 
selected one, if its Recording checkbox is checked, the Log 
Server will still record its log events.

Address This is the IP Address or DNS name that was given to the 
KN9108 / KN9116 when it was added to the Log Server (see 
Configure, page 101).

Port This is the Port number assigned to the KN9108 / KN9116 
(see Configure, page 101).

Connection If the Log Server is connected to the KN9108 / KN9116, this 
field displays Connected.
If it is not connected, this field displays Waiting. This means 
that the Log Server's MAC address has not been set properly. 
It needs to be set on the Service Configuration page of the 
Administrator Utility (see page 39).

Days This field displays the number of days that the KN9108 / 
KN9116's log events are to be kept in the Log Server's 
database before expiration (see Configure, page 101).

Description This field displays the descriptive information given for the 
KN9108 / KN9116 when it was added to the Log Server (see 
Configure, page 101).
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Chapter 9
LDAP Server Configuration

Introduction

The KVM Over the NETTM switch allows log in authentication and 
authorization through external programs. This chapter describes how to 
configure Active Directory for KVM Over the NETTM switch authentication 
and authorization.

To allow authentication and authorization via LDAP or LDAPS, the Active 
Directory’s LDAP Schema must be extended so that an extended attribute 
name for the KVM Over the NETTM switch – iKN2116-userProfile – is added 
as an optional attribute to the person class.

Note: Authentication refers to determining the authenticity of the person 
logging in; authorization refers to assigning permission to use the 
device’s various functions.

In order to configure the LDAP server, you will have to complete the following 
procedures: 1) Install the Windows Server Support Tools; 2) Install the Active 
Directory Schema Snap-in; and 3) Extend and Update the Active Directory 
Schema.

The following section provides an example of configuring LDAP under 
Windows 2003 Server.

Install the Windows 2003 Support Tools

To install the Windows 2003 Support Tools, do the following:

1. On your Windows Server CD, open the Support → Tools folder.

2. In the right panel of the dialog box that comes up, double click 
SupTools.msi.

3. Follow along with the Installation Wizard to complete the procedure.
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Install the Active Directory Schema Snap-in

To install the Active Directory Schema Snap-in, do the following:

1. Open a Command Prompt.

2. Key in: regsvr32 schmmgmt.dll to register schmmgmt.dll on your 
Active Directory computer.

3. Open the Start menu; click Run; key in: mmc /a; click OK.

4. On the File menu of the screen that appears, click Add/Remove Snap-in; 
then click Add.

5. Under Available Standalone Snap-ins, double click Active Directory 
Schema; click Close; click OK.

6. On the screen you are in, open the File menu and click Save.

7. For Save in, specify the C:\Windows\system32 directory.

8. For File name, key in schmmgmt.msc.

9. Click Save to complete the procedure.

Create a Start Menu Shortcut Entry

To create a shortcut entry on the Start Menu for the Active Directory Schema, 
do the following:

1. Right click Start; select: Open all Users → Programs → Administrative 
Tools.

2. On the File menu, select New → Shortcut

3. In the dialog box that comes up, browse to, or key in the path to 
schmmgmt.msc (C:\Windows\system32\schmmgmt.msc), then click Next.

4. In the dialog box that comes up, key in Active Directory Schema as the 
name for the shortcut, then click Finish.
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Extend and Update the Active Directory Schema

To extend and update the Active Directory Schema, you must do the following 
3 procedures: 1) create a new attribute; 2) extend the object class with the new 
attribute; and 3) edit the active directory users with the extended schema.

Creating a New Attribute
To create a new attribute do the following:

1. From the Start menu, open Administrative Tools → Active Directory 
Schema.

2. In the left panel of the screen that comes up, right-click Attributes:

3. Select New → Attribute.

4. In the warning message that appears, click Continue to bring up the 
Create New Attribute dialog box.

(Continues on next page.)
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(Continued from previous page.)

5. Fill in the dialog box to match the entries for Description and Common 
Name shown below, then click OK to complete the procedure.

Note: The Unique X500 Object ID uses periods, not commas.
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Extending the Object Class With the New Attribute
To extend the object class with the new attribute, do the following:

1. Open the Control Panel → Administrative Tools → Active Directory 
Schema.

2. In the left panel of the screen that comes up, select Classes.

3. In the right panel, right-click person:

4. Select Properties; the person Properties dialog box comes up with the 
General page displayed. Click the Attributes tab.
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5. On the Attributes page, click Add:

6. In the list that comes up, select iKVM2116-userProfile, then click OK to 
complete the procedure.
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Editing Active Directory Users
To edit Active Directory Users With the Extended Schema, do the following:

1. Run ADSI Edit. (Installed as part of the Support Tools.)

2. In the left panel, open Domain, and navigate to the DC=aten,DC=com 
CN=Users node.

3. In the right panel, locate the user you wish to edit. (Our example uses 
jason.)

4. Right-click on the user’s name and select properties.

(Continues on next page.)
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(Continued from previous page.)

5. On the Attribute Editor page of the dialog box that appears, select 
iKVM2116-userProfile from the list.

6. Click Edit to bring up the String Attribute Editor:

(Continues on next page.)
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(Continued from previous page.)

7. Key in the KVM Over the NETTM switch permission attribute values. For 
example:

Note: The possible string attributes are the same as for Radius. See the 
table on page 44 for full details.

8. Click OK. When you return to the Attribute Editor page, the iKVM2116-
userProfile entry now reflects the new permissions:

a) Click Apply to save the change and complete the procedure. Jason now 
has the same permissions as user.

b) Repeat the Editing Active Directory Users procedure for any other users 
you wish to add.
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OpenLDAP

OpenLDAP is an Open source LDAP server designed for Unix platforms. A 
Windows version can be downloaded from:

http://download.bergmans.us/openldap/openldap-2.2.29/
openldap-2.2.29-db-4.3.29-openssl-0.9.8a-
win32_Setup.exe.

OpenLDAP Server Installation
After downloading the program, launch the installer, select your language, 
accept the license and choose the target installation directory. The default 
directory is: c:\Program Files\OpenLDAP.

When the Select Components dialog box appears, select install BDB-tools and 
install OpenLDAP-slapd as NT service, as shown in the diagram, below:
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OpenLDAP Server Configuration
The main OpenLDAP configuration file, slapd.conf, has to be customized 
before launching the server. The modifications to the configuration file will do 
the following:

Specify the Unicode data directory. The default is ./ucdata.
Choose the required LDAP schemas. The core schema is mandatory.
Configure the path for the OpenLDAP pid and args start up files. The first 
contains the server pid, the second includes command line arguments.
Choose the database type. The default is bdb (Berkeley DB).
Specify the server suffix. All entries in the directory will have this suffix, 
which represents the root of the directory tree. For example, with suffix 
dc=aten,dc=com, the fully qualified name of all entries in the database 
will end with dc=aten,dc=com.
Define the name of the administrator entry for the server (rootdn), along 
with its password (rootpw). This is the server's super user. The rootdn 
name must match the suffix defined above. (Since all entry names must 
end with the defined suffix, and the rootdn is an entry.)

An example configuration file is provided in the figure, below:
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Starting the OpenLDAP Server
To start the OpenLDAP Server, run slapd (the OpenLDAP Server executable 
file) from the command line. slapd supports a number of command line 
options, the most important option is the d switch that triggers debug 
information. For example, a command of:

slapd -d 256

would start OpenLDAP with a debug level of 256, as shown in the following 
screenshot:

Note: For details about slapd options and their meanings, refer to the 
OpenLDAP documentation.
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Customizing the OpenLDAP Schema
The schema that slapd uses may be extended to support additional syntaxes, 
matching rules, attribute types, and object classes.

In the case of the KN9108 / KN9116, the User Class and the User Profile 
attribute are extended to define a new schema (e.g. kn2116.schema). The 
extended schema file used to authenticate and authorize users logging in to the 
KN9108 / KN9116 is shown in the figure, below:
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LDAP DIT Design and LDIF File

LDAP Data Structure
An LDAP Directory stores information in a tree structure known as the 
Directory Information Tree (DIT). The nodes in the tree are directory entries, 
and each entry contains information in attribute-value form. An example of the 
LDAP directory tree for the KN9108 / KN9116 is shown in the figure, below:

(Continues on next page.)
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(Continued from previous page.)

DIT Creation
The LDAP Data Interchange Format (LDIF) is used to represent LDAP entries 
in a simple text format (please refer to RFC 2849). The figure below illustrates 
an LDIF file that creates the DIT for the KN9108 / KN9116 directory tree 
(shown in the figure, above).

Note: The example above shows the permissions for a Type 1 Schema. For a 
Type 2 Schema, change the permissions line to su/user. (Where user 
represents the Username of a KN9108 / KN9116 user whose 
permissions reflect the permissions you want steve to have.)

(Continues on next page.)
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(Continued from previous page.)

Using the New Schema
To use the new schema, do the following:

1. Save the new schema file (e.g., kn2116.schema) in the /OpenLDAP/
schema/ directory.

2. Add the new schema to the slapd.conf file, as shown in the figure, below:

3. Restart the LDAP server.

4. Write the LDIF file and create the database entries in init.ldif with the 
ldapadd command, as shown in the following example:
ldapadd -f init.ldif -x -D "cn=Manager,dc=aten,dc=com" 
-w secret
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Appendix

Safety Instructions

General
Read all of these instructions. Save them for future reference.
Follow all warnings and instructions marked on the device.
Do not place the device on any unstable surface (cart, stand, table, etc.). If 
the device falls, serious damage will result.
Do not use the device near water.
Do not place the device near, or over, radiators or heat registers.
The device cabinet is provided with slots and openings to allow for 
adequate ventilation. To ensure reliable operation, and to protect against 
overheating, these openings must never be blocked or covered.
The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 
this will block its ventilation openings. Likewise, the device should not be 
placed in a built in enclosure unless adequate ventilation has been provided.
Never spill liquid of any kind on the device.
Unplug the device from the wall outlet before cleaning. Do not use liquid 
or aerosol cleaners. Use a damp cloth for cleaning.
The device should be operated from the type of power source indicated on 
the marking label. If you are not sure of the type of power available, 
consult your dealer or local power company.
The device is designed for IT power distribution systems with 230V 
phase-to-phase voltage.
To prevent damage to your installation it is important that all devices are 
properly grounded.
The device is equipped with a 3-wire grounding type plug. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace your obsolete outlet. Do not attempt to defeat the 
purpose of the grounding-type plug. Always follow your local/national 
wiring codes.
Do not allow anything to rest on the power cord or cables. Route the 
power cord and cables so that they cannot be stepped on or tripped over.
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If an extension cord is used with this device make sure that the total of the 
ampere ratings of all products used on this cord does not exceed the 
extension cord ampere rating. Make sure that the total of all products 
plugged into the wall outlet does not exceed 15 amperes.
To help protect your system from sudden, transient increases and 
decreases in electrical power, use a surge suppressor, line conditioner, or 
uninterruptible power supply (UPS).
Position system cables and power cables carefully; Be sure that nothing 
rests on any cables.
Never push objects of any kind into or through cabinet slots. They may 
touch dangerous voltage points or short out parts resulting in a risk of fire 
or electrical shock.
Do not attempt to service the device yourself. Refer all servicing to 
qualified service personnel.
If the following conditions occur, unplug the device from the wall outlet 
and bring it to qualified service personnel for repair.

The power cord or plug has become damaged or frayed.
Liquid has been spilled into the device.
The device has been exposed to rain or water.
The device has been dropped, or the cabinet has been damaged.
The device exhibits a distinct change in performance, indicating a need 
for service.
The device does not operate normally when the operating instructions 
are followed.

Only adjust those controls that are covered in the operating instructions. 
Improper adjustment of other controls may result in damage that will 
require extensive work by a qualified technician to repair.
Do not connect the RJ-11 connector marked “UPGRADE” to a public 
telecommunication network.
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Rack Mounting
Before working on the rack, make sure that the stabilizers are secured to 
the rack, extended to the floor, and that the full weight of the rack rests on 
the floor. Install front and side stabilizers on a single rack or front 
stabilizers for joined multiple racks before working on the rack.
Always load the rack from the bottom up, and load the heaviest item in the 
rack first.
Make sure that the rack is level and stable before extending a device from 
the rack.
Use caution when pressing the device rail release latches and sliding a 
device into or out of a rack; the slide rails can pinch your fingers.
After a device is inserted into the rack, carefully extend the rail into a 
locking position, and then slide the device into the rack.
Do not overload the AC supply branch circuit that provides power to the 
rack. The total rack load should not exceed 80 percent of the branch circuit 
rating.
Make sure that all equipment used on the rack – including power strips and 
other electrical connectors – is properly grounded.
Ensure that proper airflow is provided to devices in the rack.
Ensure that the operating ambient temperature of the rack environment 
does not exceed the maximum ambient temperature specified for the 
equipment by the manufacturer
Do not step on or stand on any device when servicing other devices in a 
rack.
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Technical Support
Technical support is available both by email and online (with a browser over 
the web):

International

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support support@aten.com

Online 
Support

Technical Support http://support.aten.com

Troubleshooting
Documentation
Software Updates

http://www.aten.com

Telephone Support 886-2-8692-6959

Email Support ATEN TECH support@aten-usa.com

ATEN NJ sales@aten.com

 Online 
Support

Technical Support ATEN TECH http://www.aten-usa.com/support

ATEN NJ http://support.aten.com

Troubleshooting
Documentation
Software Updates

ATEN TECH http://www.aten-usa.com

ATEN NJ http://www.aten.com

Telephone Support ATEN TECH 1-888-999-ATEN

ATEN NJ 1-732-356-1703
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Troubleshooting

Administration

General Operation

Symptom Possible Cause Action

After upgrading 
firmware, the KN9108 
/ KN9116 still appears 
to be using the old 
firmware version.

Your Internet browser is 
displaying cached web 
pages and has not fetched 
new versions of the 
KN9108 / KN9116 web 
pages.

Delete all temporary Internet files 
and cookies, close the Internet 
browser, and then open a new 
instance of the browser.

Problem Resolution

Erratic Operation Press and hold the Reset Switch (see page 8) 
for longer than three seconds.

Mouse and/or keyboard not 
responding due to improper mouse 
and/or keyboard reset.

Unplug the cable(s) from the console port(s), 
then plug it back in again.

Sudden loss of network connection 
due to local reset of KN9108 / 
KN9116.

Close your KN9108 / KN9116 connection. Wait 
approximately 30 seconds, and log in again.

Mouse Pointer Confusion If you find the display of two mouse pointers 
(local and remote) to be confusing or 
annoying, you can use the Toggle Mouse 
Display function to shrink the non-functioning 
pointer. .
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The Java Client
For mouse synchronization problems, see The On-Screen Keyboard, page 89. 
For connection and operation problems, see the table below:

The Log Server

Problem Resolution

Java Client won't 
connect to the 
KN9108 / KN9116.

1. The latest Java version must be installed on your client com-
puter.

2. Check if you need to specify the program port as well as the 
IP address. See Java Client AP Login, page 23, for details.

3. Close the Java Client, reopen it, and try again.

Pressing the 
Windows Menu key 
has no effect.

Java doesn't support the Windows Menu key.

Java Client 
performance 
deteriorates.

Exit the program and start again.

National language 
characters do not 
appear.

When entering national language characters, if your local 
keyboard is set to a non-English national language layout, you 
must set the remote computer's keyboard layout to English.

Problem Resolution

The Log Server 
program does not 
run.

The Log Server requires the Microsoft Jet OLEDB 4.0 driver in 
order to access the database.
This driver is automatically installed with Windows ME, 2000, 
and XP.
For Windows 98 and NT you will have to go to the Microsoft 
download site:

http://www.microsoft.com/data/download.htm
to retrieve the driver file:

MDAC 2.7 RTM Refresh (2.70.9001.0)
Since this driver is used in Windows Office Suite, an alternate 
method of obtaining it is to install Windows Office Suite. Once 
the driver file or Suite has been installed, the Log Server will run.
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Panel Array Mode

The WinClient ActiveX Viewer or AP

Problem Resolution

Low resolution video in Panel 
Array Mode.

Increase the number of panels that are displayed.

Some users only receive a partial 
image when multiple remote 
users are logged in concurrently.

The first user to invoke Panel Array Mode should 
set it to display a minimum of four panels.

Problem Resolution

WinClient ActiveX Viewer won't 
connect to the KN9108 / KN9116.

DirectX 8.0 or higher must be installed on your 
computer.

Remote mouse pointer is out of 
sync.

1. Use the AutoSync feature (see Video Settings, 
page 82), to sync the local and remote monitors.

2. If that doesn't resolve the problem, use the 
Adjust Mouse feature (see The On-Screen Key-
board, page 89) to bring them back in sync.

3. If the two methods described above fail to 
resolve the problem, use the Toggle Mouse Dis-
play function.

4. Set mouse acceleration to zero. See Additional 
Mouse Synchronization Procedures, page 131, 
for details.

Part of remote window is off my 
monitor.

If Keep Screen Size is not enabled, use the 
AutoSync feature (see Video Settings, page 82) to 
synchronize the local and remote monitors. If it is 
enabled, see the discussion on page 92.

The remote screen display is 
rotated 90 degrees.

Enable Keep Screen Size. See the discussion on 
page 92 for details.

I cannot run Net Meeting when 
the WinClient ActiveX Viewer is 
running.

Enable Keep Screen Size. (See the discussion on 
page 92 for details.)



KN9108 / KN9116 User Manual

130

Sun Systems

* These solutions work for most common Sun VGA cards. If using them fails 
to resolve the problem, consult the Sun VGA card's manual.

Mac Systems

Problem Resolution

Video display problems with 
HDB-15 interface systems 
(e.g. Sun Blade 1000 servers).

The display resolution should be set to 1024 x 768.
Under Text Mode:
1. Go to OK mode and issue the following com-

mands:

setenv output-device screen:r1024x768x60
reset-all

Under XWindow:
1. Open a console and issue the following command:

m64config -res 1024x768x60
2. Log out.
3. Log in.

Video display problems with 
13W3 interface systems (e.g. 
Sun Ultra servers).*

The display resolution should be set to 1024 x 768.
Under Text Mode:
1. Go to OK mode and issue the following com-

mands:

setenv output-device screen:r1024x768x60
reset-all

Under XWindow:
1. Open a console and issue the following command:

ffbconfig -res 1024x768x60
2. Log out.
3. Log in.

Problem Resolution

When I log in to the switch 
with my Safari browser, it 
hangs when I use the 
Snapshot feature.

Force close Safari, then reopen it. Don’t use the 
Snapshot feature in the future.

To use the Snapshot feature with Safari, upgrade to Mac 
OS 10.4.11 and Safari 3.0.4.
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Additional Mouse Synchronization Procedures
If the mouse synchronization procedures mentioned in the manual fail to 
resolve mouse pointer problems for particular computers, try the following:

Note: 1. These procedures are to be performed on the computers attached to 
the KN9108 / KN9116's ports - not on the computer you are using to 
access the KN9108 / KN9116.

2. In order for the local and remote mice to synchronize, you must use 
the generic mouse driver supplied with the Windows operating 
system. If you have a third party driver installed - such as one 
supplied by the mouse manufacturer - you must remove it.

1. Windows 2000:
Set the mouse speed to the middle position; set the mouse acceleration to 
None (Control Panel → Mouse → Mouse Properties → Motion):
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2. Windows XP / Windows Server 2003:
Set the mouse speed to the middle position; disable Enhance Pointer 
Precision (Control Panel → Printers and Other Hardware → Mouse → 
Pointer Options):

3. Windows ME / Windows 95:
Set the mouse speed to the middle position; disable mouse acceleration 
(click Advanced to get the dialog box for this).

4. Windows NT / Windows 98:
Set the mouse speed to the slowest position.

Sun / Linux
Open a terminal session and issue the following command:

Sun: xset m 1
Linux: xset m 0
or
xset m 1
(If one doesn’t help, try the other.)
Linux using the Redhat AS3.0 mouse mode: xset m 1
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Self-Signed Private Certificates

If you wish to create your own self-signed encryption key and certificate, a free 
utility – openssl.exe – is available for download over the web at 
www.openssl.org. To create your private key and certificate do the following:

1. Go to the directory where you downloaded and extracted openssl.exe to.

2. Run openssl.exe with the following parameters:
openssl req -new -newkey rsa:1024 -days 3653 -nodes -x509 
-keyout CA.key  -out CA.cer -config openssl.cnf

Note: 1. The command should be entered all on one line (i.e., do not press 
[Enter] until all the parameters have been keyed in).

2. If there are spaces in the input, surround the entry in quotes (e.g., 
“ATEN International”).

To avoid having to input information during key generation the following 
additional parameters can be used:

/C /ST /L /O /OU /CN /emailAddress.

Examples
openssl req -new -newkey rsa:1024 -days 3653 -nodes -x509 
-keyout CA.key  -out CA.cer -config openssl.cnf -subj 
/C=yourcountry/ST=yourstateorprovince/L=yourlocationor 
city/O=yourorganiztion/OU=yourorganizationalunit/
CN=yourcommonname/emailAddress=name@yourcompany.com

openssl req -new -newkey rsa:1024 -days 3653 -nodes -x509 
-keyout CA.key  -out CA.cer -config openssl.cnf -subj 
/C=CA/ST=BC/L=Richmond/O="ATEN International"/OU=ATEN
/CN=ATEN/emailAddress=eservice@aten.com.tw

Importing the Files
After the openssl.exe program completes, two files – CA.key (the private key) 
and CA.cer (the self-signed SSL certificate) – are created in the directory that 
you ran the program from. These are the files that you upload in the Private 
Certificate panel of the Maintenance page (see page 59).
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Administrator Login Failure

If you are unable to perform an Administrator login (because the Username and 
Password information has become corrupted, or you have forgotten it, for 
example), there is a procedure you can use to clear the login information.

Note: Performing this procedure also returns all settings to their defaults.

To clear the login information (and return all settings to their defaults), do the 
following:

1. Power off the KN9108 / KN9116 and remove its housing.

2. Using a jumper cap, short the jumper on the mainboard labeled J8.

3. Power on the switch.

4. When the front panel LEDs flash, power off the switch.

5. Remove the jumper cap from J8.

6. Close the housing and power on the KN9108 / KN9116.
After powering on the unit, you can use the default Username and 
Password (see The Local Console, page 25), to log in.

J8
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Specifications

Function KN9108 KN9116

Computer Connections Direct 8 16

Maximum 64 (via cascade) 128 (via cascade)

Port Selection OSD; Hotkey; Pushbuttons

Connectors Console 
Port

Keyboard 1 x 6-pin Mini-DIN Female (Purple)

Video  1 x HDB-15 Female (Blue)

Mouse 1 x 6-pin Mini-DIN Female (Green)

KVM Port 8 x SPHD-17 F (Yellow) 16 x SPHD-17 F (Yellow)

Power 1 x 3-prong AC socket

LAN 1 x RJ-45 Female

PON 1 x DB-9 Male (Black)

Switches Reset 1 x Semi-recessed Pushbutton

Power 1 x Rocker

Port Selection 2 x Pushbutton

LEDs On Line 8 (Green) 16 (Green)

Selected 8 (Orange) 16 (Orange)

Power 1 (Blue)

Link 1 (Green)

10 / 100Mbps 1 (Orange / Green)

Emulation Keyboard/Mouse PS/2

Video 1600 x 1200 @ 60Hz; DDC2B

Scan Interval 1–255 secs

I/P Rating 100V–240V; 50/60Hz; 250mA

Power Consumption 120V/60Hz/12W; 230V/50Hz/12W

Environment Operating Temp. 0–40° C

Storage Temp. -20–60° C

Humidity 0–80% RH

Physical 
Properties

Housing Metal

Weight 4.00 kg 4.20 kg

Dimensions L x W x H 43.72 x 26.00 x 4.40 cm (19" 1U)
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Compatible Cascade Switches

The following Altusen and ATEN KVM switches can be cascaded from the 
KN9108 / KN9116. Some KVM Over the NetTM features may not be supported, 
depending on the functionality of the cascaded switch:

CS88A
CS9134
CS9138
KH98

OSD Factory Default Settings

The factory default settings are as follows:

About SPHD Connectors

Setting Default

OSD Hotkey [Scroll Lock] [Scroll Lock]

Port ID Display Port Number + Name

Port ID Display Duration 5 Seconds

Scan / Skip Mode All

Scan Duration 10 Seconds

Screen Blanker 0 Minutes (disabled)

Beeper On

Accessible Ports F (Full) For all Users on all Ports

This product uses SPHD connectors for its KVM and/or 
Console ports. We have specifically modified the shape of these 
connectors so that only KVM cables that we have designed to 
work with this product can be connected.
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Trusted Certificates

Overview
When you try to log in to the device from your browser, a Security Alert 
message appears to inform you that the device’s certificate is not trusted, and 
asks if you want to proceed.

The certificate can be trusted, but the alert is triggered because the certificate’s 
name is not found on Microsoft list of Trusted Authorities. You have two 
options: 1) you can ignore the warning and click Yes to go on; or 2) you can 
install the certificate and have it be recognized as trusted.

If you are working on a computer at another location, accept the certificate 
for just this session by clicking Yes.
If you are working at your own computer, install the certificate on your 
computer (see below for details). After the certificate is installed, it will be 
recognized as trusted.
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Installing the Certificate
To install the certificate, do the following:

1. In the Security Alert dialog box, click View Certificate. The Certificate 
Information dialog box appears:

Note: There is a red and white X logo over the certificate to indicate that it is 
not trusted.

2. Click Install Certificate.

3. Follow the Installation Wizard to complete the installation. Unless you 
have a specific reason to choose otherwise, accept the default options.

4. When the Wizard presents a caution screen:

Click Yes.
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5. Next, click Finish to complete the installation; then click OK to close the 
dialog box.

Certificate Trusted
The certificate is now trusted:

When you click View Certificate, you can see that the red and white X logo is 
no longer present – further indication that the certificate is trusted:
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Mismatch Considerations
If the site name or IP address used for generating the certificate no longer 
matches the current address of the switch a mismatch warning occurs:

You can click Yes to go on, or you can disable mismatch checking.

To disable mismatch checking, do the following:

1. After the page you are logging in to comes up open the browser’s Tools 
menu; Select Internet Options → Advanced.

2. Scroll to the bottom of the list and uncheck Warn about trusted 
certificates:

3. Click OK. The next time you run the browser the change will be in effect.
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Limited Warranty

ATEN warrants this product against defects in material or workmanship for a period of one (1) year 
from the date of purchase. If this product proves to be defective, contact ATEN's support 
department for repair or replacement of your unit. ATEN will not issue a refund. Return requests 
can not be processed without the original proof of purchase.

When returning the product, you must ship the product in its original packaging or packaging that 
gives an equal degree of protection. Include your proof of purchase in the packaging and the RMA 
number clearly marked on the outside of the package.

This warranty becomes invalid if the factory-supplied serial number has been removed or altered 
on the product.

This warranty does not cover cosmetic damage or damage due to acts of God, accident, misuse, 
abuse, negligence or modification of any part of the product. This warranty does not cover damage 
due to improper operation or maintenance, connection to improper equipment, or attempted repair 
by anyone other than ATEN. This warranty does not cover products sold AS IS or WITH FAULTS.

IN NO EVENT SHALL ATEN'S LIABILITY EXCEED THE PRICE PAID FOR THE 
PRODUCT. FURTHER, ATEN SHALL NOT BE RESPONSIBLE FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE 
OF THE PRODUCT, ITS ACCOMPANYING SOFTWARE, OR ITS DOCUMENTATION. 
ATEN SHALL NOT IN ANY WAY BE RESPONSIBLE FOR, WITHOUT LIMITATION, LOSS 
OF DATA, LOSS OF PROFITS, DOWNTIME, GOODWILL, DAMAGE OR REPLACEMENT 
OF EQUIPMENT OR PROPERTY, AND ANY EXPENSES FROM RECOVERY, 
PROGRAMMING, AND REPRODUCTION OF ANY PROGRAM OR DATA.

ATEN makes no warranty or representation, expressed, implied, or statutory with respect to its 
products, contents or use of this documentation and all accompanying software, and specifically 
disclaims its quality, performance, merchantability, or fitness for any particular purpose.

ATEN reserves the right to revise or update its product, software or documentation without 
obligation to notify any individual or entity of such revisions, or update.

For details about extended warranties, please contact one of our dedicated 
value added resellers.
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Windows Client, 2
Activating the OSD, 61
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